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II-4 Sobre este Manual

Sobre este Manual

Este manual descreve como fazer ajustes e configurações 
para permitir que você use os recursos avançados desta 
unidade.

Para obter os procedimentos de operações básicas da unidade, consulte 

“Instruções de operação (Volume I Operações básicas)”.

Como visualizar este Manual

Sobre a definição de valores
Os valores de configuração mostrados em negrito são as 
configurações padrão de fábrica.

Exemplos:

Sobre as referências
As referências ao Manual de instruções (Volume I 
Operações bádicas) são indicadas pela marca c conforme 
a seguir.

Exemplo 1:
Faders de canal (c Operações básicas: “Nomes e funções 
dos componentes”)
Exemplo 2:
Para obter mais detalhes, consulte “Lista de padrão de 
efeitos” (c Operações básicas).

Para encontrar informações sobre um 
determinado tópico
Consulte “Índice” (página II-60) no final deste manual.
O índice indica se as informações podem ser encontradas 
no “Volume I Operações básicas” ou no “Volume II 
Configurações avançadas” e os respectivos números de 
páginas.

Botão Parâmetro Significado Intervalo da 
configuração

V3 Format Formato do sinal 108059, 108050, 
720p59, 720p50, 
480i59, 576i50, 
Test1, Test2, Test3

V4 Aspect Taxa de aspecto 16:9, 4:3
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Introdução

A unidade permite que você realize ajustes finos e defina efeitos, transições e áudio 
do vídeo para poder realizar uma comutação mais sofisticada. Você também pode 
realizar comutação de vídeo 3D e usar a função de memória de quadros para gravar 
uma tela do vídeo de entrada na memória para que você possa usá-la como material 
de entrada.

Exemplos de configuração do sistema

Exemplo 1: Quando o sistema SD

Computador do apresentador 

Microfone do 
apresentador

Projetor

VIDEO

DVI-D

Microfone do anfitrião

DVI-I

SDI

VIDEO

SDI

PA etc.

Visor do Multi Viewer

Fones de ouvido

Visor de monitoramento PGM

Equipamento de gravação 
com entrada SDI

Câmera com saída SDI

Equipamento de gravação 
com saída SDI

Reprodutor de
 CD/DVD

SDI

Drive flash USB 
(material de CG)

PGM

SDI

MIC/LINE

MIC/LINE

LINE

Cabo de 
conversão 

DVI⇔HDMI

Câmeras com saída VIDEO
II-5Introdução
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escrição
 Exemplo 2: Quando o Sistema 3D

Para obter detalhes sobre as configurações dos sistemas 3D, consulte “Capítulo 6: Sistema 3D” (página II-42).

Microfone do 
apresentador

DVI-D

Microfone do anfitrião

HD SDI 
(L)

HD SDI 
(PGM (L), PGM (R))

PA etc.

Visor do Multi Viewer

Fones de ouvido

Equipamento de gravação 
com entrada HD SDI

Reprodutor de
 CD/DVD

HD SDI (L+R)

PGM

HD SDI 
(L)

Câmera 
direita

Câmera 
esquerda

HD SDI (R)

Visor de monitoramento PGM

HD SDI (R)

MIC/LINE MIC/LINE

LINE

Câmera 
direita

Câmera 
esquerda

Cabo de 
conversão 

DVI⇔HDMI
Introdução
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Descrição

Esta unidade permite que você aplique vários efeitos ao 
comutar um vídeo e compor imagens usando teclas.
Os ajustes e as configurações durante a comutação de 
vídeo são realizados por meio dos seguintes menus.

Além disso, esta unidade inclui três seções de composição 
de vídeo, M/E (Mix/Effect), Aux1 e Aux2. Ao usar Aux1 
ou Aux2, você pode mixar vídeo (PGM) criado com M/E 
(Mix/Effect) com outro vídeo.

Para obter detalhes, consulte “Delegação de barramento” 
(página II-9).

Definição do tipo de 
transição

Você pode especificar o tipo de transição que é usado ao 
realizar transições de efeito.
Você pode selecionar os seguintes tipos de transição.
Apagamento (Wipe): Use um apagamento para alternar 

da imagem atual para uma nova imagem.
NAM (Mixagem não aditiva): Compara os sinais da 

imagem atual e da nova imagem e dá prioridade ao 
sinal com o nível mais alto de luminância na saída.
Na primeira metade da transição, a imagem atual é 
mantida em 100 % e a NAM é realizada de forma 
gradual na nova imagem. No ponto de encontro, a 
NAM é realizada em ambas as imagens, que são 
mantidas em 100%. Na segunda metade, a nova 
imagem é mantida em 100% e a NAM é realizada de 
forma gradual na imagem atual.

DME (Multi-efeitos digitais): Use efeitos DME para 
alternar a imagem mostrada no momento de forma que 
ela apareça como se tivesse sendo apagada 
(apagamento DME).

Menu Settings: Menu [Effect] > [Effect Transition] 
(página II-15)

Menu Descrição Página de 
referência

Misc Define as configurações gerais de 
transição (por exemplo, taxas de 
transição, cor dos planos de fundo).

II-8

Effect Define o tipo de transição. II-7

Define o apagamento. II-10

Define o apagamento DME. II-13

Key Define a tecla. II-19
II-7Descrição / Definição do tipo de transição
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Configurações gerais de transição (Menu [Misc])

Você pode definir a taxa de transição e o fundo colorido (ColBg) com os itens no menu [Misc].
Pressione o botão MISC no bloqueio de controle do menu para exibir o menu [Misc].

Item do 
menu

Descrição Botão Parâmetro Significado Intervalo da 
configuração

Transition 
Rate (1/2)

Você pode definir o tempo (taxa de transição) que leva para 
alternar entre os vídeos quando uma transição é executada com 
o botão AUTO TRANS, botão KEY TRANS ou botão FTB em 
cada transição.

Dicas
• A taxa de transição das transições efeito também podem ser 

configuradas em [Effect Transition] no menu [Effect]. (Consulte 
a página II-15)

• As taxas de transição de incorporação podem ser 
configuradas em [Key Transition] no menu [Key]. (Consulte a 
página II-24)

V2 Effect Taxa de transição 
para transição de 
efeito

1 a 999 quadros 
(30)

V3 Key Taxa de transição 
para transição de 
incorporação

1 a 999 quadros 
(30)

V4 FTB Taxa de transição 
para FTB

1 a 999 quadros 
(30)

Transition 
Rate (2/2)

V3 Aux1 Taxa de transição 
para Aux1

1 a 999 quadros 
(30)

V4 Aux2 Taxa de transição 
para Aux2

1 a 999 quadros 
(30)

Color BKGD Um sinal de cor pode ser gerado na unidade e usado como um 
plano de fundo monocromático. Os sinais de cor podem ser 
atribuídos aos botões de ponto cruzado (botão PGM e botão 
PST) e então usados.

V2 Lum Luminância 0.00 a 100.00

V3 Sat Saturação 0.00 a 100.00

V4 Hue Tonalidade 359.99 a 0.00

Port Enable Ativar ou desativar a porta GPI e RS-232C que é usada para 
operação com dispositivos externos.

Para obter detalhes sobre os controles dos dispositivos externos, consulte 
“Capítulo 7: Controlar dispositivos externos” (página II-45).

V3 GPI Ativa/desativa a 
porta GPI

Enbl (ativar), 
Disbl (desativar)

V4 RS232C Ativa/desativa a 
porta RS-232C 
(para expansão 
futura)

Enbl (ativar), 
Disbl (desativar)
Configurações gerais de transição (Menu [Misc])



  C
apítulo 2  C

om
utação de vídeo
Delegação de barramento

Esta unidade inclui três seções de composição de vídeo, M/E (Mix/Effect), Aux1 e Aux2. Cada bloco inclui quarto ou dois 
barramentos e pode executar transições.
No entanto, Aux1 é dedicado ao barramento Aux1 PGM e à mixagem do barramento Aux1 PST, Aux2 é dedicado ao 
barramento Aux2 PGM e a mixagem, os apagamentos, as incorporações do barramento Aux2 PST e outros efeitos também 
não podem ser adicionados a eles.

Como usar os botões de delegação 
de barramento

Ligue (ou seja, acenda) um destes botões pressionando-o 
para selecionar os objetos de controle para a seção de 
controle de ponto cruzado e a seção de controle de 
transição.

Para selecionar uma fonte de incorporação
Pressione um botão de ponto cruzado PST/KEY enquanto 
pressiona o botão KEY.

Mixagem de vídeo criado com M/E 
(Mix/Effect) com outro vídeo

Ao usar Aux1 ou Aux2, você pode mixar vídeo (PGM) 
criado com M/E (Mix/Effect) com outro vídeo.
Esta seção descreve o procedimento para usar Aux1 como 
um exemplo.

Definições preliminares

1 Selecione o programa Aux1 como o programa de saída 
de vídeo.

Menu Settings: Menu [Setup] > menu [Video 
(Output)] (página II-55)

2 Defina Aux1 como sinal de referência para o tally no 
ar.

Entrada de vídeo Saída de vídeo

Pré-visualização

Programa

Aux1 Pré-visualização

Aux1 Programa

Aux2 Pré-visualização

Aux2 Programa

Barramento Aux1 PGM

Barramento Aux1 PST

Barramento Aux2 PGM

Barramento Aux2 PST

Barramento de preenchimento de 
origem

Barramento de preenchimento de 
incorporação

Barramento PST

Barramento PGM

Aux1

Aux2

M/E
(Mix/Effect)

Botão de 
delegação de 
barramento

Objeto para controle

Seção de controle de ponto cruzado Seção de 
controle de 
transiçãoLinha PGM Linha PST/KEY

BKGD Barramento PGM Barramento PST MIX, EFF

KEY Barramento PGM Barramento de 
preenchimento de 
incorporação, 
barramento de 
preenchimento de 
origem

MIX, EFF

AUX 1 Barramento 
Aux1 PGM

Barramento 
Aux1 PST

MIX 
somente

AUX 2 Barramento 
Aux2 PGM

Barramento 
Aux2 PST

MIX 
somente
II-9Delegação de barramento
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Menu Settings: Menu [Setup] > menu [GPI/Tally] > 
[On Air Source] (página II-48)

Operação de mixagem

1 Pressione o botão de delegação de barramento AUX 1.

2 Selecione um PGM nos botões de ponto cruzado 
PGM.

3 Selecione o sinal que deseja mixar nos botões de ponto 
cruzado PST/KEY.

4 Execute a transição usando a alavanca do fader, o 
botão CUT ou o botão AUTO TRANS.

Dica
As configurações do Aux1 e do Aux2 não são 
armazenadas em memórias de quadros.

Configuração de 
apagamentos

Um apagamento é um efeito de transição que alterna para 
o vídeo seguinte com a aplicação de um efeito que remove 
o vídeo de saída do programa de forma que pareça que ele 
está sendo apagado pelo vídeo seguinte.
Com esta unidade, você pode realizar as seguintes 
configurações.
• Seleção do padrão e da direção dos apagamentos 

(página II-11)
• Como fazer ajustes finos nos padrões de apagamento 

(página II-11)
• Adição da Borda ao Padrão de apagamento (página 

II-12)

Esta seção descreve os efeitos e as operações básicas de 
apagamento.
Os ajustes de apagamento são feitos no menu [Effect].

Para obter detalhes sobre o item de menu, consulte “Detalhes do menu 

[Effect]” (página II-15).

O menu [Effect] não aparece no modo 3D.

Operações básicas de apagamento

Dica

Selecione o vídeo para a saída do programa.

r

Selecione o próximo vídeo para a saída.

r

Pressione o botão de seleção de tipo de transição EFF.

r

Defina o tipo de transição como [Wipe]. 

r

Selecione o padrão e a direção do apagamento.

r

Faça ajustes finos no padrão de apagamento se necessário.

r

Execute a transição.
Configuração de apagamentos
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Seleção do padrão e da direção dos 
apagamentos

Um apagamento poderá ser definido para prosseguir na 
direção normal de apagamento (normal) ou na direção 
inversa do apagamento (reverse). Você também pode 
especificar que normal e inverso serão alternados cada vez 
que uma transição terminar (normal/reverse).

Seleção do padrão de apagamento
Você pode selecionar o padrão de apagamento usando um 
dos três métodos a seguir.
• Selecione dentre os padrões atribuídos aos botões 

numéricos (seleção direta).

Para obter detalhes, consulte “Seleção de efeitos com o teclado numérico 

(Seleção direta)” (c Operações básicas).

• Digite o número do padrão com os botões numéricos.

Para obter detalhes, consulte “Especificação de efeitos por número de 

padrão” (c Operações básicas).

• Especifique o número do padrão no menu [Effect].

Especificação do número do padrão no 
menu [Effect]
Menu Settings: [Wipe Adjust] (página II-15)

Para obter detalhes sobre os números de padrão de apagamento, consulte 

“Lista de padrão de efeitos” (c Operações básicas).

Como fazer ajustes finos nos 
padrões de apagamento

Você pode definir a posição de um padrão de apagamento 
e aplicar diversas variações e modificadores no menu 
[Wipe Modify].

Para exibir o menu [Wipe Modify]
Exiba o menu [Effect], gire o botão V1 para selecionar 
[Wipe Adjust] e pressione esse botão.

Definição da posição de apagamento
A posição de apagamento pode ser definida no menu 
[Wipe Modify] ou com o ponteiro X-Y na seção de 
controle do menu.

Menu Settings: Menu [Wipe Modify] > [Positioner] 
(página II-16), [Positioner Adjust] (página II-16)

Para definir a posição com o ponteiro X-Y
Pressione o botão POS na seção de controle do menu para 
que ele acenda e então ajuste a posição controlando o 
ponteiro X-Y.

Definição do método de rotação de um 
padrão de apagamento
Você pode selecionar dentre os seguintes três métodos de 
rotação de padrões de apagamento.

Ângulo (Angle)
Realiza o apagamento com o padrão inclinado em um 
ângulo fixo.

Velocidade (Speed)
Gira o padrão em uma velocidade fixa durante a transição.

Magnitude (Magnitude)
Gira o padrão apenas no ângulo definido para uma 
transição.

Normal Inverso

Posicionador ligado Posicionador desligado

Ângulo desligado Ângulo ligado
II-11Configuração de apagamentos
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Menu Settings: Menu [Wipe Modify] > [Rotation] 
(página II-16), [Rotation Adjust] (página II-17)

Definição da relação de aspecto de um 
padrão de apagamento
Você pode alterar livremente a relação de aspecto de um 
padrão de apagamento.

Menu Settings: Menu [Wipe Modify] > [Aspect] 
(página II-17)

Replicação de um padrão de apagamento
O mesmo padrão pode ser colocado até 63 vezes de forma 
horizontal ou vertical ou em ambas as direções.

Além disso, você pode selecionar dentre os seguintes 
quatro métodos para colocar os padrões.

1: Todos os padrões são orientados da mesma forma
2: As linhas com números pares são movidas na horizontal
3: As colunas com números pares e as linhas com números 

pares são invertidas
4: As colunas com números pares e as linhas com números 

pares são invertidas e as linhas com números pares são 
movidas na horizontal

Menu Settings: Menu [Wipe Modify] > [Multi] 
(página II-17), [Multi Adjust] (página II-17)

Adição da Borda ao Padrão de 
apagamento

Você pode adicionar uma margem em volta do padrão 
(borda), desfocar a margem em volta do padrão (suave) e 
desfocar uma borda de margem adicionada (margem 
suave).
Também é possível ajustar a cor da borda.

Margem (Border): Você pode ajustar a largura da 
margem.

Borda suave (Soft Edge): Você pode ajustar a 
condição de desfoque da borda.

Margem suave (Soft Border): Você pode ajustar a 
largura da margem e a condição de desfoque para a 
borda da margem.

Menu Settings: [Wipe Edge] (página II-15), [Wipe 
Edge Color] (página II-15)

Ajuste de aspecto 
desligado

Ajuste de aspecto 
ligado

Multifunção desligado Multifunção ligado

1 2 3 4

Margem Margem suaveBorda suave
Configuração de apagamentos
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Configuração de 
apagamentos DME

Os apagamentos DME são efeitos que usam DME 
(multi-efeitos digitais) para alternar a imagem mostrada no 
momento de forma que ela apareça como se tivesse sendo 
apagada.
Com esta unidade, você pode realizar as seguintes 
configurações.
• Seleção do padrão e da direção dos apagamentos DME 

(página II-13)
• Como fazer ajustes finos nos padrões de apagamento 

DME (página II-13)
• Adição de uma borda a um padrão de apagamento DME 

(página II-14)
• Ajustando a cor de fundo de um apagamento DME 

(página II-14)

Esta seção descreve os efeitos e as operações básicas de 
apagamentos DME.
Os ajustes de apagamento DME são feitos no menu 
[Effect].

Para obter detalhes sobre o item de menu, consulte “Detalhes do menu 

[Effect]” (página II-15).

Operações básicas de apagamento 
DME

Seleção do padrão e da direção dos 
apagamentos DME

Para obter detalhes sobre o padrão e a direção dos apagamentos DME, 

consulte “Seleção do padrão e da direção dos apagamentos” (página II-11).

Menu Settings: [DME Wipe Adjust] (página II-15)

Como fazer ajustes finos nos 
padrões de apagamento DME

Você pode ajustar a posição de um padrão de apagamento 
DME, ajustar o tamanho da subtela durante o PinP, realizar 
o recorte para cortar a borda da imagem e fazer outros 
ajustes no menu [DME Wipe Modify].

Para exibir o menu [DME Wipe Modify]
Exiba o menu [Effect], gire o botão V1 para selecionar 
[DME Wipe Adjust] e pressione esse botão.

Definição da posição de apagamento DME
A posição de apagamento pode ser definida no menu 
[DME Wipe Modify] ou com o ponteiro X-Y na seção de 
controle do menu.

Menu Settings: Menu [DME Wipe Modify] > 
[Positioner] (página II-18), [Positioner Adjust] 
(página II-18)

Para definir a posição com o ponteiro X-Y
Pressione o botão POS na seção de controle do menu para 
que ele acenda e então ajuste a posição controlando o 
ponteiro X-Y.

Ajuste do tamanho da subtela usada para 
Frame In/Out e PinP
Você pode ajustar o tamanho da subtela que aparece 
quando você usa os padrões de apagamento Frame In/Out 
e PinP DME.

Menu Settings: Menu [DME Wipe Modify] > [Size] 
(página II-18)

Corte (recorte) da borda de uma imagem
Você pode recortar partes da imagem que são 
desnecessárias.

A função de recorte não está disponível nos seguintes 
casos.
• Quando o padrão de efeito Mosaic ou Defocus está 

selecionado
• Quando o botão de seleção de próxima transição KEY 

está selecionado

Menu Settings: Menu [DME Wipe Modify] > [Crop H] 
(página II-18), [Crop V] (página II-18)

Selecione o vídeo para a saída do programa.

r

Selecione o próximo vídeo para a saída.

r

Pressione o botão de seleção de tipo de transição EFF.

r

Defina o tipo de transição como [DME]. 

r

Selecione o padrão e a direção do apagamento DME.

r

Faça ajustes finos no padrão de apagamento DME se necessário.

r

Execute a transição.

Nota
II-13Configuração de apagamentos DME
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O processo de recorte quando a transição é executada é o 
seguinte.

Corte (Cut): O recorte é mantido durante a execução 
da transição e removido no momento em que a 
transição termina.

Últimos 5% (Last 5%): O recorte é mantido como 
está até que a transição chegue a 95% e é removido 
durante os 5% restantes.

Linear : O recorte é removido de forma linear do 
início da transição de acordo com o andamento da 
transição.

Adição de uma borda a um padrão 
de apagamento DME

Com um apagamento DME, você pode adicionar uma 
margem em volta do padrão (margem) e desfocar a borda 
de uma margem adicionada (margem suave).
Também é possível ajustar a cor e a cor de fundo da borda.

Para obter detalhes sobre como adicionar uma borda, consulte “Adição da 

Borda ao Padrão de apagamento” (página II-12).

Menu Settings: [DME Wipe Edge], [DME Wipe Edge 
Color] (página II-15)

Ajustando a cor de fundo de um 
apagamento DME

Você pode ajustar a cor de fundo de um apagamento DME.

Menu Settings: [DME Wipe Bkgd Color] (página II-16)

• A cor de fundo do apagamento DME pode ser usada 
apenas em padrões de apagamento DME Flip Tumble.

• A cor de fundo do apagamento DME é compartilhada 
com a cor da borda do padrão de apagamento.
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Detalhes do menu [Effect]

Menu [Effect]

Pressione o botão EFF no bloqueio de controle do menu para exibir o menu [Effect].

Item do 
menu

Descrição Botão Parâmetro Significado Intervalo da 
configuração

Página de 
referência

Effect 
Transition

Defina a taxa e o tipo de transição que é usado 
ao realizar transições de efeito.

V3 Rate A taxa de transição 
quando executado 
com o botão AUTO 
TRANS

1 a 999 quadros (30) II-7

V4 Type Tipo de transição Wipe, NAM, DME

Wipe Adjust Defina a direção e o padrão do apagamento. 
Também é possível pressionar o botão V1 para 
exibir o menu [Wipe Modify] (página II-16).

V1 Modify Pressione o botão 
para exibir o menu 
[Wipe Modify] 

– II-10

V3 Direct Direção do 
apagamento

Norm (normal), 
N/R (normal/
reverse), Rev 
(reverse)

II-13

V4 PtnNum Número do padrão 
de apagamento

1 a 24

Wipe Edge Adicione uma margem em volta do padrão 
(borda), desfocar a margem em volta do 
padrão (suave) e desfocar uma margem 
adicionada (margem suave).

V2 Type Tipo de borda de 
apagamento

Off, Border, Soft (soft 
edge) e S-Brdr (soft 
border)

II-12

V3 Width Ajusta a largura da 
margem

0.00 a 100.00

V4 Soft Condição de 
desfoque da borda

0.00 a 100.00

Wipe Edge 
Color

Ajusta o nível de cor da borda de apagamento. V2 Lum Luminância 0.00 a 100.00 II-12

V3 Sat Saturação 0.00 a 100.00

V4 Hue Tonalidade 359.99 a 0.00

DME Wipe 
Adjust

Defina a direção e o padrão do apagamento 
DME. 
Também é possível pressionar o botão V1 para 
exibir o menu [DME Wipe Modify] (página 
II-18).

 Dica
·Quando o botão de seleção de próxima 
transição KEY está selecionado, 1101 a 1102 
(Flip Tumble), 1251 (PinP), 1701 (Mosaic) e 
1702 (Defocus) não podem ser selecionados.

V1 Modify Pressione o botão 
para exibir o menu 
[DME Wipe Modify] 

– II-13

V3 Direct Direção do 
apagamento DME

Norm (normal), 
N/R (normal/reverse 
mode) e Rev 
(reverse)

V4 PtnNum Número do padrão 
de apagamento 
DME

1001 a 1008 (Slide), 
1021 a 1031 
(Squeeze), 1041 a 
1044 (Door), 1201 a 
1208/1221 a 1224 
(Frame In/Out), 1101 
a 1102 (Flip Tumble), 
1251 (PinP), 1701 
(Mosaic), 1702 
(Defocus)

DME Wipe 
Edge

Adicionar uma margem em volta do padrão 
DME (borda), desfocar a margem em volta de 
uma borda adicionada (margem suave).

V2 Type Tipo de borda de 
apagamento DME

Off, Border, S-Brdr 
(soft border)

II-14

V3 Width Ajusta a largura da 
margem

0.00 a 100.00 (2.00)

V4 Soft Condição de 
desfoque da borda

0.00 a 100.00
II-15Detalhes do menu [Effect]
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Menu [Wipe Modify]

Exiba o menu [Wipe Modify] pressionando o botão V1 enquanto [Wipe Adjust] está selecionado.

DME Wipe 
Edge Color

Ajusta o nível de cor da borda de apagamento 
DME.

V2 Lum Luminância 0.00 a 100.00 
(14.63)

II-14

V3 Sat Saturação 0.00 a 100.00 
(50.09)

V4 Hue Tonalidade 359.99 a 0.00 
(349.83)

DME Wipe 
Bkgd Color

Ajusta a cor de fundo do apagamento DME. V2 Lum Luminância da cor 
de fundo

0.00 a 100.00 II-14

V3 Sat Saturação da cor 
de fundo

0.00 a 100.00

V4 Tonalidade Tonalidade da cor 
de fundo

359.99 a 0.00

Item do 
menu

Descrição Botão Parâmetro Significado Intervalo da 
configuração

Página de 
referência

Item do 
menu

Descrição Botão Parâmetro Significado Intervalo da 
configuração

Página de 
referência

Positioner Gire o posicionador para ajustar a posição do 
apagamento como ligado/desligado.
Se você também selecionar [On] com o botão 
V3, o padrão se moverá do local para o qual o 
padrão foi movido com o posicionador para o 
centro da tela como resultado da transição.

 Dica
Os padrões nos quais o posicionador pode ser 
usado são os seguintes.

17, 18, 21, 22, 23 e 24

V3 AutoCT Desliga ou liga a 
função auto center

Off, On II-11

V4 Pos Desliga ou liga o 
posicionador

Off, On

Positioner 
Adjust

Ajuste a posição do apagamento.
Se voc deseja restaurar o valor do ajuste para 
“0.00”, pressione o boto V4.

V2 Pos H Ajusta a posição na 
direção horizontal

–200.00 a +200.00 
(0.00) (Um valor 
negativo move o 
padrão para a 
esquerda e um valor 
positivo o move para 
a direita)

II-11

V3 Pos V Ajusta a posição na 
direção vertical

–200.00 a +200.00 
(0.00) (Um valor 
negativo move o 
padrão para baixo e 
um valor positivo o 
move para cima)

V4 Center Restaura o valor do 
ajuste para “0”

–

Rotation Definir a direção de rotação de um padrão de 
apagamento.

V4 Rotate Tipo de rotação Off, Angle, Speed, 
Mag (magnitude)

II-11
Detalhes do menu [Effect]
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Rotation 
Adjust

Defina os parâmetros com base no tipo de 
rotação selecionado em [Rotation].
• Quando [Angle] estiver selecionado: Definir 

[Angle].
• Quando [Speed] estiver selecionado: Definir 

[Speed].
• Quando [Mag] estiver selecionado: Definir 

[Angle] e [Mag].

Sobre a definição de valores
Ângulo: –100.00 corresponde ao estado em 

que o padrão é girado uma vez no sentido 
anti-horário e +100.00 ao estado em que 
o padrão é girado uma vez no sentido 
horário. 0.00 corresponde a um estado 
sem rotação.

Mag: –200.00 gira o padrão duas vezes no 
sentido anti-horário e +200.00 gira o 
padrão duas vezes no sentido horário. 
0.00 não gira o padrão.

Velocidade: –100.00 é a velocidade de uma 
rotação no sentido anti-horário por 
segundo e +100.00 é velocidade de uma 
rotação no sentido horário por segundo. 
0.00 corresponde a um estado 
estacionário.

V2 Angle • Ângulo de 
inclinação do 
padrão ([Angle])

• Ângulo de 
inclinação do 
padrão quando a 
transição é 
iniciada ([Mag])

–100.00 a +100.00 
(0.00)

II-11

V3 Mag Quantidade de 
rotações durante a 
transição

–200.00 a +200.00 
(0.00)

V4 Speed Velocidade de 
rotação do padrão

–100.00 a +100.00 
(0.00)

Aspect Alteração da relação de aspecto de um padrão 
de apagamento Definir a relação de aspecto 
para um valor negativo estica o padrão 
verticalmente para torná-lo mais longo na 
direção vertical e definir a relação de aspecto 
em para um valor positivo estica o padrão 
horizontalmente para torná-lo mais longo na 
direção horizontal.

V3 Aspect Desliga ou liga o 
ajuste de aspecto

Off, On II-12

V4 Ratio Ajusta a relação de 
aspecto

–100.00 a +100.00 
(0.00)

Multi Liga ou desliga a multifunção de replicação de 
padrões de apagamento.

V4 Multi Liga ou desliga a 
multifunção

Off, On II-12

Multi Adjust O mesmo padrão pode ser colocado até 63 
vezes de forma horizontal ou vertical ou em 
ambas as direções.

V2 H Mult O número de 
padrões a serem 
colocados em uma 
direção horizontal

1 a 63 II-12

V3 V Mult O número de 
padrões a serem 
colocados em uma 
direção vertical

1 a 63

V4 InvTyp Método de 
colocação do 
padrão

1 a 4

Item do 
menu

Descrição Botão Parâmetro Significado Intervalo da 
configuração

Página de 
referência
II-17Detalhes do menu [Effect]
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Menu [DME Wipe Modify]

Exiba o menu [DME Wipe Modify] pressionando o botão V1 enquanto [DME Wipe Adjust] está selecionado.

A função de recorte não está disponível nos seguintes casos.
• Quando o padrão de efeito 1701 (Mosaic) ou 1702 (Defocus) está selecionado
• Quando o botão de seleção de próxima transição KEY está selecionado

Item do 
menu

Descrição Botão Parâmetro Significado Intervalo da 
configuração

Página de 
referência

Positioner Gire o posicionador para ajustar a posição do 
apagamento DME como ligado/desligado.

 Dica
Os padrões nos quais o posicionador pode ser 
usado são os seguintes.

1031, 1201 a 1208, 1221 a 1224 e 1251

V4 Pos Desliga ou liga o 
posicionador

Off, On II-13

Positioner 
Adjust

Ajuste a posição do apagamento DME.
Se voc deseja restaurar o valor do ajuste para 
“0.00”, pressione o boto V4.

V2 Pos H Ajusta a posição na 
direção horizontal

–200.00 a +200.00 
(0.00) (Um valor 
negativo move o 
padrão para a 
esquerda e um valor 
positivo o move para a 
direita)

II-13

V3 Pos V Ajusta a posição na 
direção vertical

–200.00 a +200.00 
(0.00) (Um valor 
negativo move o 
padrão para baixo e 
um valor positivo o 
move para cima)

V4 Center Restaura o valor do 
ajuste para “0”

–

Size Você pode ajustar o tamanho da subtela 
quando usar padrões de apagamento DME 
1201 a 1208 (Frame In/Out), 1221, 1224 
(Frame In/Out) e 1251 (PinP).

Notas sobre valores de configuração
Param: Defina a relação de redução/

ampliação como um percentual. O ajuste 
100.00 é igual ao tamanho da imagem de 
entrada.

V3 Size Desliga ou liga o 
ajuste de tamanho

Off, On II-13

V4 Param Ajusta o tamanho 0.00 a 200.00 (100.00)

Crop H Liga ou desliga a função de recorte e define as 
posições à esquerda e à direita usadas ao 
recortar partes desnecessárias de uma 
imagem.

V2 Crop Desliga ou liga o 
recorte

Off, On II-13

V3 Left Posição para cortar 
a parte esquerda 
de uma imagem

–100.00 a +100.00

V4 Right Posição para cortar 
a parte direita de 
uma imagem

–100.00 a +100.00

Crop V Define a ação executada quando uma 
transição é realizada e define as posições 
superior e inferior usadas ao recortar partes 
desnecessárias de uma imagem.

V2 Trans Ação quando a 
transição é 
executada

Cut, Last5%, Linear II-13

V3 Top Posição para cortar 
a parte superior de 
uma imagem

–100.00 a +100.00

V4 Bottom Posição para cortar 
a parte inferior de 
uma imagem

–100.00 a +100.00

Dica
Detalhes do menu [Effect]
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Definição de 
incorporações

Uma incorporação é uma função para cortar a imagem de 
fundo e inserir uma imagem ou um texto naquela parte. O 
sinal para o corte de um plano de fundo é chamado de 
origem de incorporação, o sinal para preencher a parte 
cortada é chamado de preenchimento de incorporação e o 
bloqueio do processamento de uma incorporação é 
chamado de keyer.

Esta seção descreve como fazer ajustes finos nas 
incorporações.

Com esta unidade, você pode realizar as seguintes 
configurações de incorporações.
• Operações básicas de incorporações (página II-19)
• Definição de transições de incorporação (página II-20)
• Seleção do padrão e da direção dos apagamentos de 

incorporação (página II-20)
• Como fazer ajustes finos nos padrões de apagamento de 

incorporação (página II-20)
• Configuração de apagamentos DME de incorporação 

(página II-20)
• Como fazer ajustes finos nos padrões de apagamento 

DME de incorporação (página II-21)
• Seleção de tipos de incorporação (página II-21)
• Como fazer ajustes finos na incorporação de luminância 

(página II-21)
• Como fazer ajustes finos na incorporação linear (página 

II-21)
• Como fazer ajustes finos no Chroma Key (página II-21)
• Definição de preenchimento e de origem de 

incorporação (página II-21)
• Definição de uma máscara para uma incorporação 

(página II-22)
• Adição de uma borda a uma incorporação (página 

II-22)
• Ajuste do tamanho e da posição da incorporação 

(página II-22)

Para obter os procedimentos de operações básicas de incorporação de 

luminância e chroma key, consulte “Composição de imagens com 

incorporações” (c Operações básicas).

Faça os ajustes de incorporação e de transição de 
incorporação no menu [Key].

Para obter detalhes sobre o item de menu [Key], consulte “Detalhes do menu 

[Key]” (página II-24).

No modo 3D, o menu [Key] não é exibido.

Operações básicas de 
incorporações

Use o seguinte procedimento para realizar operações 
básicas para incorporações.

Dependendo de onde você deseja executar a transição de 
incorporação, realize uma das duas variações a seguir de 
operações básicas de incorporação.
• Transição de efeito (selecione o botão de próxima 

transição KEY) (página II-19) 
• Transição de incorporação (página II-20)

Transição de efeito

Seleção de material

Configuração de transição j

Configuração de incorporação j

Dica

Seleção de material

r

Configuração de transição

r

Configuração de incorporação

r

Execução da transição

Pressione o botão de delegação de barramento KEY.

r

Selecione o vídeo para a saída do programa.

r

Selecione o material da incorporação (ouseja, a imagem a ser 
sobreposta na saída de vídeo do programa).

1) Use o menu [Effect].

Pressione o botão de seleção de próxima transição KEY para 
acendê-lo.

r

Pressione o botão MIX ou o botão EFF.

r

Defina o tipo de transição como transição de efeito.1)

r

Selecione o padrão e a direção do apagamento DME, se 

necessário.1)

Selecione o tipo de incorporação.

r

Faça ajustes finos na incorporação se necessário.
II-19Definição de incorporações
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Execução da transição j

Transição de incorporação

Seleção de material

Configuração de transição j

Configuração de incorporação j

Execução da transição j

Definição de transições de 
incorporação

Defina a taxa de incorporação e o tipo de transição de 
incorporação para quando uma transição de incorporação 
é realizada.
Você pode selecionar os seguintes tipos de transição.
Cut: Inserir (cut in) ou remover (cut out) rapidamente a 

incorporação.
Mixagem (Mix): Inserir (fade in) ou remover (fade out) a 

incorporação de forma gradual.
Apagamento (Wipe): Use o apagamento para recortar o 

plano de fundo e, em seguida, incorpore um 
incorporação.

DME (Multi-efeitos digitais): Use um efeito DME e 
aplique o mesmo efeito do apagamento DME à 
incorporação (apagamento DME de incorporação).

Menu Settings: [Key Transition] (página II-24)

Seleção do padrão e da direção dos 
apagamentos de incorporação

Você pode recortar o plano de fundo de um padrão de 
apagamento selecionado na transição de uma incorporação 
específica e então incorporar um incorporação.

Menu Settings: [Key Wipe Modify] (página II-25)

Para obter detalhes sobre direções de apagamento, consulte “Seleção do 

padrão e da direção dos apagamentos” (página II-11).

Para obter detalhes sobre os números de padrão de apagamento, consulte 

“Lista de padrão de efeitos” (c Operações básicas).

Como fazer ajustes finos nos 
padrões de apagamento de 
incorporação

Você pode definir a posição de um padrão de apagamento 
e aplicar diversas variações e modificadores no menu [Key 
Wipe].

Para exibir o menu [Key Wipe]
Exiba o menu [Key], gire o botão V1 para selecionar [Key 
Wipe] e pressione esse botão.

Os itens de configuração no menu [Key Wipe Modify] são os mesmos de 

[Wipe Modify] no menu [Effect]. Para obter detalhes sobre a configuração 

de itens, consulte as seções correspondentes em “Como fazer ajustes finos 

nos padrões de apagamento” (página II-11).

Configuração de apagamentos DME 
de incorporação

Em uma incorporação, você pode fazer os mesmos ajustes 
de um apagamento DME.

Menu Settings: [Key DME Wipe] (página II-25)

Para obter detalhes sobre direções de apagamento DME, consulte “Seleção 

do padrão e da direção dos apagamentos” (página II-11).

Para obter detalhes sobre os números de padrão de apagamento, consulte 

“Lista de padrão de efeitos” (c Operações básicas).

Execute a transição usando a alavanca do fader, o botão CUT ou 
o botão AUTO TRANS.

Pressione o botão de delegação de barramento KEY.

r

Selecione o vídeo para a saída do programa.

r

Selecione o material da incorporação (ou seja, a imagem a ser 
sobreposta na saída de vídeo do programa).

1) Use o menu [Key].

Defina o tipo de transição da transição de incorporação.1)

r

Selecione o padrão e a direção do apagamento de incorporação 

ou apagamento de incorporação DME, se necessário.1)

Selecione o tipo de incorporação.

r

Faça ajustes detalhados na incorporação se necessário.

Execute a transição usando o botão KEY TRANS.
Definição de incorporações
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Como fazer ajustes finos nos 
padrões de apagamento DME de 
incorporação

Você pode ajustar a posição de um padrão de apagamento 
DME de incorporação e o tamanho de uma sub-tela 
durante o Frame In/Out e PinP no menu [Key DME Wipe 
Modify].

Para exibir o menu [Key DME Wipe Modify]
Exiba o menu [Key], gire o botão V1 para selecionar [Key 
DME Wipe] e pressione esse botão.

Os itens de configuração que podem ser ajustados no menu [Key DME Wipe 

Modify] são os mesmos do [DME Wipe Modify] em um apagamento DME 

(exceto pelo item de recorte). Consulte as seções correspondentes em “Como 

fazer ajustes finos nos padrões de apagamento DME” (página II-13).

Seleção de tipos de incorporação

Selecione os tipos de incorporações para recortar das 
imagens.
Você pode selecionar os seguintes tipos de incorporação.
Lum (incorporação de luminância) / Lin 

(incorporação linear): Use isso ao inserir títulos ou 
logotipos na imagem.
Use sinais de brilho como os de texto em preto e 
branco como a origem de incorporação.

As incorporações lineares possuem uma variabilidade 
de ganho reduzida que permite um ajuste mais preciso 
quando comparadas às incorporações de luminância.

Chr (chroma key): Use isso ao combinar as imagens de 
pessoas com uma imagem de fundo, por exemplo.
Crie a origem da incorporação com base em uma 
determinada cor na imagem de entrada.

Menu Settings: [Key Type Select] (página II-24)

Como fazer ajustes finos na 
incorporação de luminância

Você pode fazer ajustes finos na condição de recorte do 
fundo, na densidade da incorporação e outras 
configurações para compor o vídeo com as incorporações 
de luminância.

Menu Settings: [Lum Key Adjust (1/2)] (página II-24), 
[Lum Key Adjust (2/2)] (página II-24), [Lum Key 
Mode] (página II-24)

Como fazer ajustes finos na 
incorporação linear

Você pode fazer ajustes finos na condição de recorte do 
fundo, na densidade da incorporação e outras 
configurações para compor o vídeo com as incorporações 
lineares.

Menu Settings: [Lin Key Adjust (1/2)] (página II-24), 
[Lin Key Adjust (2/2)] (página II-25), [Lin Key Mode] 
(página II-25)

Como fazer ajustes finos no Chroma 
Key

Quando, por exemplo, você deseja realizar um ajuste fini 
nos resultados do ajuste do chroma key no menu [Manual 
Chromakey], você pode especificar cada configuração de 
chroma key manualmente. Você também pode substituir 
as cores de fundo (normalmente azuis) que passam para as 
partes de contorno do vídeo sendo combinado (como o 
cabelo de uma pessoa) por cores como o cinza para 
torná-las menos aparentes.

Para obter mais detalhes de como fazer ajustes de chroma key, consulte 

“Composição de imagens com Chroma Keys” (c Operações básicas).

Para exibir o menu [Manual Chromakey]
Exiba o menu [Key], gire o botão V1 para selecionar 
[Chromakey Manual Adj] e pressione esse botão.

Para obter detalhes sobre o menu [Manual Chromakey], consulte “Menu 

[Manual Chromakey]” (página II-29).

Definição de preenchimento e de 
origem de incorporação

Selecione o sinal a ser usado para o preenchimento de 
incorporação e o modo de seleção de sinal para ser usado 
na origem da incorporação.

Menu Settings: [Key Fill/Src Select] (página II-24), 
[Key Fill Mat Adjust] (página II-24)

Modos de seleção de origem de incorporação
Self: Seleciona o sinal do barramento da origem da 

incorporação como origem da incorporação.
Se o chroma key for selecionado como tipo da 
incorporação, selecione [Self].

Automático (Auto): Selecione automaticamente o sinal 
do barramento de preenchimento da incorporação e i 
sinal emparelhado atribuído a um botão de ponto 
cruzado como a origem da incorporação.

Dica
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Split: Permite que você selecione o sinal de barramento de 
origem da incorporação pelo sinal de barramento de 
preenchimento de incorporação.

Para obter detalhes sobre a seleção, consulte “Como selecionar o 

preenchimento de incorporação ou a fonte de incorporação 

separadamente” (c Operações básicas).

Os pares de preenchimento e origem de incorporação 
selecionados quando [Auto] está selecionado são os 
seguintes.

1) Se você realizar incorporação com vídeo em branco como a origem 
da incorporação, o vídeo de preenchimento da incorporação 
preencherá toda a tela.

Modos de seleção de preenchimento de 
incorporação
Barramento (Bus): Sinal selecionado com um botão de 

ponto cruzado
Matte: Sinal gerado com o gerador de matizes de cor na 

unidade (você pode ajustar a cor em [Key Fill Mat 
Adjust])

Definição de uma máscara para uma 
incorporação

A máscara de incorporação é uma função para mascarar 
uma parte do sinal de incorporação.

Menu Settings: [Key Mask] (página II-25)

Adição de uma borda a uma 
incorporação

Você pode adicionar uma margem à borda da incorporação 
(margem) e desfocar a borda da incorporação (suave).

Quando você adiciona uma margem a uma incorporação, 
as posições do preenchimento e da origem da incorporação 
se moverão para baixo.

Definição de modificadores para a borda 
da incorporação
Ligue ou desligue o modo soltar e defina o tipo de 
modificador.
• Se você ligar o modo soltar, as posições do 

preenchimento e da origem da incorporação se movem 
para baixo, independentemente da adição de margens. 
Se não desejar mover a posição da incorporação em 
resposta à borda da incorporação estar ligada ou 
desligada, ligue o modo soltar.

• Você pode selecionar os seguintes modificadores.

Normal: O estado no qual uma margem em volta da 
incorporação não é adicionada.

Margem (Border): Permite que você adicione uma 
margem em volta da incorporação e ajuste a largura 
e a densidade da margem.

Menu Settings: [Key Edge Type] (página II-26), 
[Border Adjust] (página II-26), [Border Matte Adjust] 
(página II-26), [Key Soft Edge] (página II-26)

Ajuste do tamanho e da posição da 
incorporação

No menu [Resizer], você pode aplicar efeitos, como 
reduzir/ampliar, mover e alterar a relação de aspecto para 
a parte da incorporação criada da mesma forma que o 
DME (função de redimensionamento).

• Se um efeito de redimensionamento for aplicado à 
incorporação, haverá um atraso de um quadro na 
imagem.

Preenchimento de 
incorporação

Origem de incorporação

Vídeo de memória de quadro Incorporação de memória 
de quadro

Vídeo preto Vídeo branco1)

Sinais diferentes dos acima Mesmo sinal do 
preenchimento de 
incorporação

World MarketV2008

World MarketV
Parte da máscaraA parte interna da 

máscara será usada 
na incorporação.

 Fundo

Nota

Normal Margem

Notas
Definição de incorporações
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• Das funções apagamento DME, apagamento de 
incorporação DME e redimensionamento, apenas uma 
pode ser usada por vez.

Para ativar a função de redimensionamento
Exiba o menu [Key], gire o botão V1 para selecionar 
[Resizer] e pressione o botão V4 para selecionar [On]. 
(Consulte a página II-24)

Para exibir o menu [Resizer]
Exiba o menu [Key], gire o botão V1 para selecionar 
[Resizer] e pressione esse botão.

Para obter detalhes sobre o menu [Resizer], consulte “Menu [Resizer]” 

(página II-27).
II-23Definição de incorporações
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Detalhes do menu [Key]

Menu [Key]

Pressione o botão KEY na seção de controle do menu para exibir o menu [Key].

Item do 
menu

Descrição Botão Parâmetro Significado Intervalo da 
configuração

Página de 
referência

Key Transition Defina a taxa e o tipo de transição usado 
quando a transição de incorporação é 
executada com o botão KEY TRANS.

V3 Rate Taxa de transição 1 a 999 (30) II-20

V4 Type Tipo de transição Cut, Mix, Wipe, 
DME

Key Type 
Select

Selecione os tipos de incorporações para 
recortar das imagens.

V4 Type Tipo de 
incorporação

Lum (incorporação 
de luminância), Lin 
(incorporação 
linear), Chr 
(Chromakey)

II-21

Resizer Selecione se a função de redimensionamento 
que aplica efeitos, como reduzir, ampliar, 
mover e alterar a relação de aspecto, na parte 
da incorporação criada da mesma forma que o 
DME deverá ser usada.
Também é possível pressionar o botão V1 para 
exibir o menu [Resizer](página II-27).

V1 Select Pressione o botão 
para exibir o menu 
[Resizer]

– II-22

V4 Resize Liga ou desliga a 
função de 
redimensionamento

Off, On

Key Fill/Src 
Select

Selecione o sinal a ser usado para o 
preenchimento de incorporação e o modo de 
seleção de sinal para ser usado na origem da 
incorporação.

V3 Source Modo de seleção da 
origem da 
incorporação

Self, Auto, Split II-21

V4 Fill Sinal a ser usado 
como origem da 
preenchimento

Bus, Matte

Key Fill Mat 
Adjust

Ajusta a cor da matiz do preenchimento de 
incorporação.

V2 Lum Luminância da 
matiz de cor

0.00 a 100.00 II-21

V3 Sat Saturação da matiz 
de cor

0.00 a 100.00

V4 Hue Tonalidade da matiz 
de cor

359.99 a 0.00

Lum Key 
Adjust (1/2)

Ajuste a condição de corte do fundo e a nitidez 
do contorno da incorporação de luminância.

V3 Clip Condição de corte 
do fundo (valor do 
clipe)

+109.59 a –7.31 
(0.00)

–

V4 Gain Nitidez do contorno 
(valor de ganho)

–100.00 a +100.00 
(0.00)

Lum Key 
Adjust (2/2)

Ajusta a densidade de incorporação de 
luminância.

V4 Dens Densidade de 
incorporação

0 a 100.00 –

Lum Key 
Mode

Ligue o modo de limpeza para a incorporação 
de luminância. Quando o modo de limpeza 
está ligado, a origem de incorporação não 
afeta o preenchimento de incorporação, que é 
adicionado inalterado ao fundo.

 Dica
O modo de limpeza é eficaz quando se usam 
sinais que consistem em um preenchimento e 
uma origem de incorporação, como com o 
gerador de caracteres.

V4 Clean Desliga ou liga o 
modo de limpeza

Off, On –

Lin Key 
Adjust (1/2)

Ajusta a condição de corte do fundo e a nitidez 
do contorno da incorporação linear.

V3 Clip Condição de corte 
do fundo (valor do 
clipe)

+109.59 a –7.31 
(0.00)

–

V4 Gain Nitidez do contorno 
(valor de ganho)

–100.00 a +100.00 
(0.00)
Detalhes do menu [Key]
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Lin Key 
Adjust (2/2)

Ajusta a densidade da incorporação linear. V4 Dens Densidade de 
incorporação

0 a 100.00 –

Lin Key Mode Ligue o modo de limpeza para a incorporação 
linear. Quando o modo de limpeza está ligado, 
a origem de incorporação não afeta o 
preenchimento de incorporação, que é 
adicionado inalterado ao fundo.

 Dica
O modo de limpeza é eficaz quando se usam 
sinais que consistem em um preenchimento e 
uma origem de incorporação, como com o 
gerador de caracteres.

V4 Clean Desliga ou liga o 
modo de limpeza

Off, On –

Chromakey 
Auto Adj

Exibe o menu [Auto Chromakey] (página II-28) 
que permite que você especifique uma parte 
do vídeo da frente (por exemplo, a cor azul do 
fundo) e use-a como referência para criar 
automaticamente a imagem de chroma key.

V1 Auto Pressione o botão 
para exibir o menu 
[Auto Chromakey]

– Instruções 
de Operação 
(Operação 
básica)

Chromakey 
Manual Adj

Exibe o menu [Manual Chromakey] (página 
II-29) para fazer ajustes finos no chroma key.

V1 Manual Pressione o botão 
para exibir o menu 
[[Manual 
Chromakey]

– II-21

Key Invert Inverter preto e branco na origem da 
incorporação.

V4 Invert Desliga ou liga a 
inversão da origem 
de incorporação

Off, On –

Key Wipe Defina a direção e o padrão do apagamento de 
incorporação. 
Também é possível pressionar o botão V1 para 
exibir o menu [Key Wipe Modify] (página II-29).

V1 Modify Pressione o botão 
para exibir o menu 
[Key Wipe Modify] 

– II-20

V3 Direct Direção do 
apagamento

Norm (normal), 
N/R (normal/
reverse), Rev 
(reverse)

II-20

V4 PtnNum Número do padrão 
de apagamento

1 a 24

Key Wipe 
Edge

Desfoca a borda de um padrão de 
apagamento de incorporação (borda suave).

V3 Soft Desliga ou liga a 
borda suave

Off, On –

V4 Param Condição de 
desfoque da borda

0.00 a 100.00

Key DME 
Wipe

Defina a direção e o padrão do apagamento de 
incorporação DME.
Também é possível pressionar o botão V1 para 
exibir o menu [Key DME Wipe Modify] (página 
II-31).

V1 Modify Pressione o botão 
para exibir o menu 
[Key DME Wipe 
Modify]

– II-20

V3 Direct Direção do 
apagamento de 
incorporação DME

Norm (normal), N/R 
(normal/reverse), 
Rev (reverse)

V4 PtnNum Número do padrão 
de apagamento 
DME

1001 a 1008 
(Slide), 1021 a 
1031 (Squeeze), 
1041 a 1044 
(Door), 1201 a 
1208, 1221 a 1224 
(Frame In/Out)

Key Mask Define a função máscara de incorporação para 
mascarar uma parte de um sinal de 
incorporação.

V3 Mask Liga ou desliga a 
função de máscara

Off, On II-22

V4 Invert Liga ou desliga a 
inversão de 
máscara

Off, On

Item do 
menu

Descrição Botão Parâmetro Significado Intervalo da 
configuração

Página de 
referência
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Key Mask 
Box H

Especifica as posições direita e esquerda da 
caixa de máscara.

V3 Left Posição do lado 
esquerdo

–100.00 a +100.00 
(–50.00)

II-22

V4 Right Posição do lado 
direito

–100.00 a +100.00 
(+50.00)

Key Mask 
Box V

Especifica as posições superior e inferior da 
caixa de máscara.

V3 Top Posição da parte 
superior

–100.00 a +100.00 
(+50.00)

II-22

V4 Bottom Posição da parte 
inferior

–100.00 a +100.00 
(–50.00)

Key Edge 
Type

Ligue ou desligue o modo soltar e defina os 
modificadores da borda de incorporação.

V3 Drop Desliga ou liga o 
modo soltar

Off, On II-22

V4 Type Tipo de borda de 
incorporação

Norm (normal), 
Border

Border Adjust Ajusta a largura da margem. V3 Dens Densidade da 
margem

0.00 a 100.00 II-22

V4 Width Margem com 0.00 a 4.00

Border Matte 
Adjust

Ajusta a cor da matiz da margem. V2 Lum Luminosidade da 
matiz da margem

0.00 a 100.00 II-22

V3 Sat Saturação da matiz 
da margem

0.00 a 100.00

V4 Hue Tonalidade da matiz 
da margem

359.99 a 0.00

Key Soft 
Edge

Desfoca a borda da incorporação (borda 
suave). Liga a borda da incorporação e ajusta 
a condição de desfoque da borda.

V3 Soft Desliga ou liga a 
borda suave

Off, On II-22

V4 Param Condição de 
desfoque da borda

0.00 a 100.00

Fine Key Liga ou desliga a função de incorporação fina 
para realizar ajustes finos na posição da 
margem do sinal de incorporação.

V4 Fine Liga ou desliga a 
função de 
incorporação fina

Off, On –

Fine Key 
Adjust H

Quando a função de incorporação fina está 
ligada, realize ajustes finos nas posições 
direita e esquerda da margem do sinal de 
incorporação.

V3 Left Posição do lado 
esquerdo

–2.00 a +2.00 
(0.00)

–

V4 Right Posição do lado 
direito

–2.00 a +2.00 
(0.00)

Fine Key 
Adjust V

Quando a função de incorporação fina está 
ligada, realize ajustes finos nas posições 
superior e inferior da margem do sinal de 
incorporação.

V3 Top Posição da parte 
superior

–2.00 a +2.00 
(0.00)

–

V4 Bottom Posição da parte 
inferior

–2.00 a +2.00 
(0.00)

Item do 
menu

Descrição Botão Parâmetro Significado Intervalo da 
configuração

Página de 
referência
Detalhes do menu [Key]
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Menu [Resizer]

Exiba o menu [Resizer] pressionando o botão V1 enquanto [Resizer] (página II-24) está selecionado.

Item do 
menu

Descrição Botão Parâmetro Significado Intervalo da 
configuração

Página de 
referência

Rotation 
Mode

Selecione se a função de redimensionamento 
se move em 2D ou 3D.

 Dica
Dependendo da configuração, os intervalos de 
ajustes das seguintes configurações 
[Location], [Aspect] e [Rotation] irão variar.

V3 Axis Seleciona o eixo de 
rotação da 
transformação 3D

X, Y –

V4 Enable Alterna entre 
transformação 2D e 
3D

On (3D transform), 
Off (2D transform)

Location Reduz/amplia e move a incorporação.

Dicas
• O intervalo de configuração da direção 

horizontal difere entre HD/SD 4:3 e SD 16:9.
• O intervalo de configuração da direção 

vertical difere entre HD/SD 4:3, SD 16:9 e 
3D.

V2 Loc X Move a 
incorporação na 
direção horizontal

–100.00 a +100.00 
(0.00)

–

V3 Loc Y Move a 
incorporação na 
direção vertical

• Quando [Rotation 
Mode] está [Off], 
–100.00 a 
+100.00 (0.00)

• Quando [Rotation 
Mode] está [On], 
–9.00 a 9.00 
(0.00)

V4 Size Reduz/amplia a 
incorporação

• Quando [Rotation 
Mode] está [On], 
0.00 a 100.00 
(1.00)

• Quando [Rotation 
Mode] está [Off], 
0.00 a 1.00

Aspect Altera a relação de aspecto de uma 
incorporação.

V2 Asp X Altera o tamanho 
na direção 
horizontal

• Quando [Rotation 
Mode] está [Off], 
0.00 a 100.00 
(1.00)

• Quando [Rotation 
Mode] está [On], 
fixo em 1.00 
(ajuste 
desativado)

–

V3 Asp Y Altera o tamanho 
na direção vertical

• Quando [Rotation 
Mode] está [Off], 
0.00 a 100.00 
(1.00)

• Quando [Rotation 
Mode] está [On], 
fixo em 1.00 
(ajuste 
desativado)

V4 Ratio Altera a relação de 
aspecto

• Quando [Rotation 
Mode] está [Off], 
0.00 a 2.00 (1.00)

• Quando [Rotation 
Mode] está [On], 
fixo em 1.00 
(ajuste 
desativado)
II-27Detalhes do menu [Key]
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Menu [Auto Chromakey]

Exiba o menu [Auto Chromakey] pressionando o botão V1 enquanto [Chromakey Auto Adj] (página II-25) está 
selecionado.

Rotation Gira a incorporação e ajusta a perspectiva. V2 Rot X Quantidade de 
rotação do eixo X

• Quando [Rotation 
Mode] está [Off], 
fixo em 0.00 
(ajuste 
desativado)

• Quando [Rotation 
Mode] está [On], 
–100.00 a 
+100.00 (0.00)

–

V3 Rot Y Quantidade de 
rotação do eixo Y

• Quando [Rotation 
Mode] está [Off], 
fixo em 0.00 
(ajuste 
desativado)

• Quando [Rotation 
Mode] está [On], 
–100.00 a 
+100.00 (0.00)

V4 Pers Perspectiva • Quando [Rotation 
Mode] está [Off], 
fixo em 1.00 
(ajuste 
desativado)

• Quando [Rotation 
Mode] está [On], 
0.00 a 1.00

Item do 
menu

Descrição Botão Parâmetro Significado Intervalo da 
configuração

Página de 
referência

Item do 
menu

Descrição Botão Parâmetro Significado Intervalo da 
configuração

Página de 
referência

Sample Mark Exibe a marca de amostra (isto é, a caixa 
branca) para especificar a cor do corte (ou 
seja, a cor a ser usada como referência do 
chroma key).

V4 Mark Desliga ou liga a 
exibição da marca 
de amostra

Off, On Operações 
básicas

Sample Mark 
Adjust

Ajusta a largura e a posição da marca de 
amostra.

 Dica
Dependendo da configuração de tamanho, os 
intervalos de ajustes das posições horizontais 
e verticais irão variar.

V2 Pos H Posição na direção 
horizontal

–100.00 a +100.00 
(0.00)

Operações 
básicas

V3 Pos V Posição na direção 
vertical

–100.00 a +100.00 
(0.00)

V4 Size Tamanho 1.00 a 100.00 
(25.00)

Auto Adjust 
Execute

Executar chroma key automático.
Quando você pressiona o botão V4, o chroma 
key automático é executado usando a cor 
especificada com a marca de amostra como 
referência e a imagem composta é liberada.

V4 Start Pressione o botão 
para executar o 
chroma key 
automático.

– Operações 
básicas
Detalhes do menu [Key]
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Menu [Manual Chromakey]

Exiba o menu [Manual Chromakey] pressionando o botão V1 enquanto [Chromakey Manual Adj] (página II-25) está 
selecionado.

Menu [Key Wipe Modify]

Exiba o menu [Key Wipe Modify] pressionando o botão V1 enquanto [Key Wipe] (página II-25) está selecionado.

Item do 
menu

Descrição Botão Parâmetro Significado Intervalo da 
configuração

Página de 
referência

Chr Key 
Adjust (1/2)

Ajuste a condição de corte do fundo, a nitidez 
do contorno e outras configurações.

V2 Hue Tonalidade da cor 
que você deseja 
cortar

359.99 a 0.00 (0.00) –

V3 Clip Saturação da cor 
que você deseja 
cortar

0.00 a 100.00 
(50.00)

V4 Gain Nitidez do contorno 
(valor de ganho)

0.00 a 100.00 (0.00)

Chr Key 
Adjust (2/2)

Ajusta a densidade do chroma key. V4 Dens Densidade de 
incorporação

0 a 100.00 –

Color Cancel Liga ou desliga a função de cancelamento de 
cor que remove as cores de fundo (por 
exemplo, tela azul) que vazam para as áreas 
do contorno do vídeo sendo combinado.

V4 Cancel Liga ou desliga a 
função de 
cancelamento de 
cor

Off, On –

Color Cancel 
Adjust

Ajuste a cor que será removida pelo 
cancelamento de cor.

V2 Lum Deslocamento do 
brilho da cor a ser 
cancelada

0.00 a 100.00 –

V3 Sat Saturação da cor a 
ser cancelada

0.00 a 100.00

V4 Hue Tonalidade da cor a 
ser cancelada

359.99 a 0.00

Chr Key 
Window

Liga ou desliga a função de janela que permite 
que você ajuste o intervalo de detecção da cor 
que você deseja remover.

 Dica
Quando a função de janela está desligada, o 
ajuste de imagem é feito no intervalo dos 
valores padrão.

V4 Window Liga ou desliga a 
função de janela

Off, On –

Chr Key 
Window Adj

Ajusta a forma da janela. V3 Crop Posição para cortar 
a parte superior da 
janela

100.00 a 0.00 
(75.00)

–

V4 Angle O ângulo no qual a 
janela é aberta

180.00 a 0.00 
(180.00)

Item do 
menu

Descrição Botão Parâmetro Significado Intervalo da 
configuração

Página de 
referência

Positioner Gire o posicionador para ajustar a posição do 
apagamento de incorporação como ligado/
desligado.
Se você também selecionar [On] com o botão 
V3, o padrão se moverá do local para o qual o 
padrão foi movido com o posicionador para o 
centro da tela como resultado da transição.

 Dica
Os padrões nos quais o posicionador pode ser 
usado são os seguintes.

17, 18, 21, 22, 23 e 24

V3 AutoCT Desliga ou liga a 
função auto center

Off, On –

V4 Pos Desliga ou liga o 
posicionador

Off, On
II-29Detalhes do menu [Key]
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Positioner 
Adjust

Ajuste a posio de apagamento de incorporao. 
Se desejar restaurar o valor para “0.00”, 
pressione o boto V4.

Notas sobre valores de configuração
Pos H: Valores negativos ajustam a posição 

para a esquerda, valores positivos para a 
direita.

Pos V: Valores negativos ajustam a posição 
para baixo, valores positivos para cima.

V2 Pos H Ajusta a posição na 
direção horizontal

–200.00 a +200.00 
(0.00)

–

V3 Pos V Ajusta a posição na 
direção vertical

–200.00 a +200.00 
(0.00)

V4 Center Restaura o valor do 
ajuste para “0”

–

Rotation Definir a direção de rotação de um padrão de 
apagamento de incorporação.

V4 Rotate Tipo de rotação Off, Angle, Speed, 
Mag (magnitude)

–

Rotation 
Adjust

Defina os parâmetros com base no tipo de 
rotação selecionado em [Rotation].
• Quando [Angle] estiver selecionado: Definir 

[Angle].
• Quando [Speed] estiver selecionado: Definir 

[Speed].
• Quando [Mag] estiver selecionado: Definir 

[Angle] e [Mag].

Sobre a definição de valores
Ângulo: –100.00 corresponde ao estado em 

que o padrão é girado uma vez no sentido 
anti-horário e +100.00 ao estado em que 
o padrão é girado uma vez no sentido 
horário. 0.00 corresponde a um estado 
sem rotação.

Mag: –200.00 gira o padrão duas vezes no 
sentido anti-horário e +200.00 gira o 
padrão duas vezes no sentido horário. 
0.00 não gira o padrão.

Velocidade: –100.00 é a velocidade de uma 
rotação no sentido anti-horário por 
segundo e +100.00 é velocidade de uma 
rotação no sentido horário por segundo. 
0.00 corresponde a um estado 
estacionário.

V2 Angle • Ângulo de 
inclinação do 
padrão ([Angle])

• Ângulo de 
inclinação do 
padrão quando a 
transição é 
iniciada ([Mag])

–100.00 a +100.00 
(0.00)

II-11

V3 Mag Quantidade de 
rotações durante a 
transição

–200.00 a +200.00 
(0.00)

V4 Speed Velocidade de 
rotação do padrão

–100.00 a +100.00 
(0.00)

Aspect Alteração da relação de aspecto de um padrão 
de apagamento de incorporação. Definir a 
relação de aspecto para um valor negativo 
estica o padrão verticalmente para torná-lo 
mais longo na direção vertical e definir a 
relação de aspecto em para um valor positivo 
estica o padrão horizontalmente para torná-lo 
mais longo na direção horizontal.

V3 Aspect Desliga ou liga o 
ajuste de aspecto

Off, On II-12

V4 Ratio Ajusta a relação de 
aspecto

–100.00 a +100.00 
(0.00)

Multi Liga ou desliga a multifunção de replicação de 
padrões de apagamento de incorporação.

V4 Multi Liga ou desliga a 
multifunção

Off, On II-12

Multi Adjust O mesmo padrão pode ser colocado até 63 
vezes de forma horizontal ou vertical ou em 
ambas as direções.

V2 H Mult O número de 
padrões a serem 
colocados em uma 
direção horizontal

1 a 63 II-12

V3 V Mult O número de 
padrões a serem 
colocados em uma 
direção vertical

1 a 63

V4 InvTyp Método de 
colocação do 
padrão

1 a 4

Item do 
menu

Descrição Botão Parâmetro Significado Intervalo da 
configuração

Página de 
referência
Detalhes do menu [Key]
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Menu [Key DME Wipe Modify]

Exiba o menu [Key DME Wipe Modify] pressionando o botão V1 enquanto [Key DME Wipe] (página II-25) está 
selecionado.

Item do 
menu

Descrição Botão Parâmetro Significado Intervalo da 
configuração

Página de 
referência

Positioner Gire o posicionador para ajustar a posição do 
apagamento de incorporação DME como 
ligado/desligado.

Dica
O posicionador pode ser usado para os 
padrões a seguir.

1031, 1201 a 1208 e 1221 a 1224

V4 Pos Desliga ou liga o 
posicionador

Off, On –

Positioner 
Adjust

Ajuste a posio do apagamento de incorporao 
DME. Se voc deseja restaurar o valor do ajuste 
para “0.00”, pressione o boto V4.

Notas sobre valores de configuração
Pos H: Valores negativos ajustam a posição 

para a esquerda, valores positivos para a 
direita.

Pos V: Valores negativos ajustam a posição 
para baixo, valores positivos para cima.

V2 Pos H Ajusta a posição na 
direção horizontal

–200.00 a +200.00 
(0.00)

–

V3 Pos V Ajusta a posição na 
direção vertical

–200.00 a +200.00 
(0.00)

V4 Center Restaura o valor do 
ajuste para “0”

–

Size Você pode ajustar o tamanho da subtela 
quando usar padrões de apagamento de 
incorporação DME 1201 a 1208 (Frame In/Out) 
e 1221 e 1224 (Frame In/Out).

Notas sobre valores de configuração
Param: Defina a relação de redução/

ampliação como um percentual. O ajuste 
100.00 é igual ao tamanho da imagem de 
entrada.

V3 Size Desliga ou liga o 
ajuste de tamanho

Off, On –

V4 Param Ajusta o tamanho 0.00 a 200.00 
(100.00)
II-31Detalhes do menu [Key]
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Descrição

Você pode realizar ajustes finos na entrada de áudio, definir os níveis do áudio e especificar os conectores a serem usados 
para saída de áudio de cada canal de áudio.
Ajuste e configure o áudio no menu [Audio Channel] de cada canal de áudio.

Para exibir o menu [Audio Channel]
Pressione o botão ACCESS/PFL na mesma coluna do fader de canal ao qual está atribuído o áudio a ser ajustado.

Para obter detalhes sobre a atribuição de um sinal de entrada a cada fader de canal, consulte“Atribuir sinais de entrada de áudio a faders de canal” 

(c Operações básicas).

Detalhes do menu [Audio Channel]

Botões ACCESS/PFL

Item do 
menu

Descrição Botão Parâmetro Significado Intervalo da 
configuração

Página de 
referência

Input Trim Ajuste os níveis de do sinal de entrada de 
áudio. Você pode ajustar individualmente os 
canais atribuídos das entradas de sinais de 
áudio desta unidade.

V4 Level Ajusta o nível de 
entrada

–15 dB a +15 dB 
(0 dB)

–

Filter Cortar a frequência alta e a frequência baixa. 
Use essas configurações para suprimir notas 
etc.

V3 L Cut Corta baixa 
frequência (100 Hz 
ou menos)

Off, On –

V4 H Cut Corta alta 
frequência (8 Hz ou 
mais)

Off, On
Descrição / Detalhes do menu [Audio Channel]
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Equalizer 
High

Use a função de equalizador para ajustar a 
qualidade do áudio ao configurar a faixa de 
alta frequência.

V2 EQ H Liga ou desliga o 
ajuste da qualidade 
de áudio da faixa 
de alta frequência

Off, On –

V3 Freq Centraliza a 
frequência da faixa 
de alta frequência 
(kHz)

1.30 k a 17.40 k
(4.75 k)

V4 Level Nível da faixa de 
alta frequência

–15 dB a +15 dB 
(0 dB)

Equalizer Mid Use a função de equalizador para ajustar a 
qualidade do áudio ao configurar a faixa de 
média frequência.

V2 EQ M Liga ou desliga o 
ajuste da qualidade 
de áudio da faixa 
de média 
frequência

Off, On –

V3 Freq Centraliza a 
frequência da faixa 
de média 
frequência (kHz)

260,0 k a 6,40 k 
(1,28 k)

V4 Level Nível da faixa de 
média frequência

–15 dB a +15 dB 
(0 dB)

Equalizer Low Use a função de equalizador para ajustar a 
qualidade do áudio ao configurar a faixa de 
baixa frequência.

V2 EQ L Liga ou desliga o 
ajuste da qualidade 
de áudio da faixa 
de baixa frequência

Off, On –

V3 Freq Centraliza a 
frequência da faixa 
de baixa frequência 
(Hz)

31.0 a 420.0 
(114.1)

V4 Level Nível da faixa de 
baixa frequência

–15 dB a +15 dB 
(0 dB)

Limiter/
Compressor

Utilize o limitador ou compressor quando 
houver entrada de áudio com grandes 
diferenças de nível.
• O limitador restringe os componentes de 

pico de um sinal de áudio com grandes 
diferenças de nível. Também comprime o 
som que ultrapassa um determinado 
volume de limite, evitando assim saídas 
com valores excessivos.

• O compressor comprime suavemente o 
nível de áudio até um nível igual ou superior 
ao nível de limite, suavizando um sinal de 
áudio com grandes diferenças de nível.

V3 Type Seleciona o método 
de compressão de 
áudio

Off, Lim (limiter), 
Comp 
(compressor)

–

V4 Thresh Nível no qual o 
limitador ou o 
compressor fazem 
efeito (limite)

0 dB a –60 dB 
(–20 dB)

Pan Ajustar o equilíbrio de áudio esquerdo e 
direito.

V4 Bal Ajusta o equilíbrio 
esquerdo e direito

15L a 15R (0) –

PGM Assign Saída de áudio do conector PGM OUT.

 Dica
O nível de saída da saída de áudio do 
conector PGM OUT pode ser ajustado com o 
fader de programa na seção de controle de 
áudio.

V4 PGM Liga ou desliga a 
saída do conector 
PGM OUT

Off, On –

MIX OUT 
Assign

Saída de áudio do conector MIX OUT. V4 MIX Liga ou desliga a 
saída do conector 
MIX OUT

Off, On –

Item do 
menu

Descrição Botão Parâmetro Significado Intervalo da 
configuração

Página de 
referência
II-33Detalhes do menu [Audio Channel]
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AUX1 OUT 
Assign

Saída de áudio do conector AUX OUT 1.
Sobre o estado do áudio de saída
Pre: Libera o áudio antes do controle de nível 

com o fader de canal de áudio.
Post: Libera o áudio no estado em que todos 

os ajustes, exceto pan, foram aplicados 
ao sinal de áudio.

V2 AUX1 Liga ou desliga a 
saída do conector 
AUX OUT 1

Off, On –

V3 Level Ajusta o nível do 
áudio

–8 a +10 dB 
(0 dB)

V4 Type Estado do áudio de 
saída

Pre, Post

AUX2 OUT 
Assign

Saída de áudio do conector AUX OUT 2.

Sobre o estado do áudio de saída
Pre: Libera o áudio antes do controle de nível 

com o fader de canal de áudio.
Post: Libera o áudio no estado em que todos 

os ajustes, exceto pan, foram aplicados 
ao sinal de áudio.

V2 AUX2 Liga ou desliga a 
saída do conector 
AUX OUT 2

Off, On –

V3 Level Ajusta o nível do 
áudio

–8 a +10 dB 
(0 dB)

V4 Type Estado do áudio de 
saída

Pre, Post

Item do 
menu

Descrição Botão Parâmetro Significado Intervalo da 
configuração

Página de 
referência
Detalhes do menu [Audio Channel]
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Descrição

O congelamento de entrada é uma função que permite que 
você congele imagens de sinais de entrada individuais.

A memória de quadros é uma função que permite que você 
congele imagens e grave-a na memória da unidade para 
que você possa usá-la como material de entrada.
As imagens armazenadas na memória do quadro podem 
ser usadas com os sinais de entrada de vídeo (FM) dos 
botões de ponto cruzado (botões PGM e PST/KEY).

O congelamento de entrada e a memória de quadros não 
estão disponíveis no modo 3D (o menu [Frame Memory] 
não é exibido).

Congelamento de 
imagens de entrada

1 Pressione o botão FM na seção de controle de menu 
para exibir o menu [Frame Memory] e gire o botão V1 
para selecionar [Input Freeze].

2 Gire o botão V3 para selecionar o sinal de entrada, gire 
o botão V4 para selecionar [On] e pressione o botão 
V4 no tempo que deseja congelar.

A imagem de entrada é congelada.

Se desejar congelar uma imagem novamente, 
selecione [Off], pressione o botão V4 e selecione [On] 
novamente.

Dica

Dica

Botão Parâmetro Significado Intervalo da 
configuração

V3 Input Seleciona o sinal 
de entrada

SDI1, SDI2, SDI3, 
SDI4, DVI, H/V1, 
H/V2, H/V3

V4 Freeze Desliga ou liga o 
congelamento

Off, On
II-35Descrição / Congelamento de imagens de entrada



II-36

  C
apítulo 4  Im

agem
 de entrada congelam

ento e m
em

ória de quadroa
Seleção da memória de 
quadros para ser usada 
como memória de 
quadros de vídeo (FM)

Exiba o menu [Frame Memory], gire o botão V1 para 
elecionar [Select] e gire o botão V4 para selecionar a 
memória de quadros na qual a imagem que você deseja 
usar como o vídeo de memória de quadros está salva.
Frame Memory 1 a 12 estão indicados como “FM1,” 
“FM2,” ... “FM12.”

Salvamento de imagens 
na memória de quadros

Selecione a memória de quadros em qual salvar (Frame 
Memory 1 a 12), selecione o sinal de entrada a ser usado 
como a origem e congele a imagem de entrada para 
gravá-la na memória.

1 Exiba o menu [Frame Memory], gire o botão V1 para 
selecionar [Frame Memory Freeze] e pressione o 
botão.

O menu [Frame Memory Freeze] é exibido.

2 Gire o botão V1 para selecionar a memória de quadros 
na qual a imagem deverá ser salva, ([Frame Memory 
1] a [Frame Memory 12]), gire os botões V2 e V3 para 
selecionar as imagens de origem, gire o botão V4 para 
selecionar [On] e pressione o botão V4.

A imagem de entrada é salva na memória.

• Se o parâmetro [Store] estiver definido como [Off], 
o vídeo de entrada da memória de quadros é 
produzido.

• Se [Src K] estiver definido como [Black] um sinal 
todo branco é atribuído à imagem de origem da 
incorporação.

3 Pressione o botão de seleção de menu FM para sair do 
menu [Frame Memory Freeze].

A memória de quadros ([Frame Memory 1] a [Frame 
Memory 12]) selecionada com o botão V1 no menu 
[Frame Memory Freeze] será atribuída automaticamente 
ao FM do sinal de entrada de vídeo e isso será refletido no 
status de seleção de [Select] no menu [Frame Memory].

Botão Parâmetro Significado Intervalo da 
configuração

V4 FM Seleção da memória de 
quadros para ser usada 
como vídeo de memória 
de quadros (FM)

FM1, FM2, FM3, 
FM4, FM5, FM6, 
FM7, FM8, FM9, 
FM10, FM11, FM12

Botão Parâmetro Significado Setting range

V2 Src V Seleciona a 
imagem de 
origem de vídeo

Black, SDI1, SDI2, 
SDI3, SDI4, DVI, 
H/V1, H/V2, H/V3, 
ColBg, PGM, Aux1, 
Aux2

V3 Src K Seleciona a 
imagem de 
origem de 
incorporação

Black, SDI1, SDI2, 
SDI3, SDI4, DVI, 
H/V1, H/V2, H/V3, 
ColBg, PGM, Aux1, 
Aux2

V4 Store Salva a imagem 
de entrada

Off, On

Dicas

Nota
Seleção da memória de quadros para ser usada como memória de quadros de vídeo (FM) / Salvamento de imagens na memória de quadros
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Importação e exportação 
de imagens

Você pode usar drive flash USB para importar imagens 
para a unidade como memória de quadros e exportar a 
memória de quadros salva na unidade.

Importação de imagens

Formatos de arquivos suportados para importação
• TGA
• TIFF
• BMP

• Insira até 25 caracteres alfanuméricos de um único byte 
(incluindo a extensão) para nomes de arquivo. Um 
arquivo com um nome de 26 caracteres ou mais não será 
exibido.

• Se uma imagem for muito grande, as partes 
protuberantes serão cortadas. Se uma imagem for muito 
pequena, as partes ausentes serão preenchidas com 
preto.

• Operações de importação não são garantidas para 
arquivos TGA e TIFF que incluem informações de 
camada.

1 Copie as imagens que deseja importar para a seguinte 
pasta em uma drive flash USB e insira drive flash USB 
no conector USB da unidade.

Nome da pasta: \Sony\MCS\FM

2 Exiba o menu [Frame Memory], gire o botão V1 para 
selecionar [Import] e pressione esse botão.

Os dados na drive flash USB são lidos e os arquivos 
que podem ser importados são exibidos.

3 Gire o botão V1 para selecionar o primeiro arquivo a 
ser importado, gire cada botão para especificar a 
memória de quadros e o número de arquivos a ser 
importado e pressione o botão V4 para iniciar a 
importação.

Quando o botão V4 está pressionado, o número 
especificado de arquivos é importado.

• Se você importar arquivos TGA ou TIFF que 
incluam canais alpha, uma memória de quadros que 
inclua uma origem de incorporação será criada.

• Você pode importar arquivos TGA compactados por 
RLE.

• Arquivos TIFF compactados não podem ser 
importados.

• Se você importar arquivos BMP, TGA ou TIFF que 
não incluam canais alpha, uma memória de quadros 
que inclua uma origem de incorporação toda branca 
será criada.

• Se uma memória de quadros estiver registrada em 
um número de memória de quadros, ela será 
sobrescrita pela imagem importada.

Exportar memória de quadros

Você pode exportar a memória de quadros armazenada na 
unidade para a drive flash USB.

1 Insira a drive flash USB na porta USB da unidade.

2 Exiba o menu [Frame Memory] e gire o botão V1 para 
selecionar [Export].

3 Gire cada botão para selecionar a memória de quadros 
a ser exportada e pressione o botão V4 para iniciar a 
exportação.

Quando o botão V4 for pressionado, o número 
espeficiado de memória de quadros será exportado.

Notas

Botão Parâmetro Significado Intervalo da 
configuração

V2 Dest Seleciona a primeira 
memória de quadros 
a ser importada

FM1, FM2, FM3, 
FM4, FM5, FM6, 
FM7, FM8, FM9, 
FM10, FM11, 
FM12

V3 Num Número de arquivos 
a importar

1 a 12

Dicas

Botão Parâmetro Significado Intervalo da 
configuração

V2 Source Selectiona a 
primeira memória de 
quadros a ser 
exportada

FM1, FM2, FM3, 
FM4, FM5, FM6, 
FM7, FM8, FM9, 
FM10, FM11, 
FM12

V3 Num Número de 
memórias de 
quadros a serem 
exportadas

1 a 12
II-37Importação e exportação de imagens



II-38

  C
apítulo 4  Im

agem
 de entrada congelam

ento e m
em

ória de quadroa
• Apenas arquivos no formato BMP podem ser 
exportados. Canais alpha não podem ser 
adicionados.

• A pasta para a qual os arquivos são exportados e os 
nomes de arquivo são como mostrados abaixo.
Nome da pasta: \Sony\MCS\FM
Nome do arquivo: AAMMDD-HHMMSS-##.bmp

(# é o número da memória de quadros [01 a 12])

Dicas
Importação e exportação de imagens
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Importar e exportar 
arquivos Dados de 
configuração

Você pode exportar os dados de configuração nos quais 
várias configurações da unidade foram salvas em uma 
drive flash USB e importar os dados de configuração 
salvos para a unidade.

Os dados de configuração contêm vários ajustes da 
unidade. Quando quiser, por exemplo, restaurar 
configurações anteriores, você poderá facilmente realizar 
essas configurações importando os dados de configuração. 
Recomendamos que você salve os dados de configuração 
regularmente, como, por exemplo, quando você alterar as 
configurações.

Exportar dados de configuração

1 Insira a drive flash USB na porta USB da unidade.

2 Pressione o botão FILE na seção de controle do menu 
para exibir o menu [File], gire o botão V1 para 
selecionar [Export Config] e pressione o botão V4 
para iniciar a exportação.

A pasta para a qual os arquivos são exportados são 
como mostrados abaixo.
Nome da pasta: 
\Sony\MCS\CONFIG\YYMMDD-HHMMSS

As configurações a seguir não são salvas em dados de 
configuração.

Botões do painel dianteiro
• ACCESS/PFL (1 a 6)
• DIM
• MONITOR SEL
• CH ON (1 a 6)
• Botões de delegação de barramento (BKGD, KEY, 

AUX 1, AUX 2)
• Botões de seleção do menu
• Botões do teclado numérico (EFF, SNAPSHOT, 

DIRECT/ESC)

Menus

Miscelânea
• Vídeo de memória de quadro

Dica

Dica

Nota

Menu Grupo Parâmetro

Frame Memory Input Freeze Input, Freeze

Select FM

Export Source, Num

Frame Memory > Freeze All –

Frame Memory > Import All –

Misc Port Enable GPI, RS232C

File All –

File > Import Config All –

File > Import Snapshot All –

Setup > System Startup Mode All

Date All

Time All
II-39Importar e exportar arquivos Dados de configuração
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Importar dados de configuração

1 Insira a drive flash USB que armazena os dados de 
configuração que você deseja restaurar no conector 
USB da unidade.

2 Exiba o menu [File], gire o botão V1 para selecionar 
[Import Config] e pressione esse botão.

Os dados na drive flash USB são lidos e os dados de 
configuração que podem ser importados são exibidos.

3 Gire o botão V1 para selecionar os dados de 
configuração a serem importados e pressione o botão 
V4 para iniciar a importação.

Quando a importação estiver concluída, uma 
mensagem será exibida solicitando que você reinicie a 
unidade.

4 Pressione o botão V3 (OK) e desligue e ligue a 
unidade.

Quando você importa os dados de configuração, o 
modo de inicialização é alterado imediatamente para 
[User].

Para obter detalhes sobre o modo de inicialização, consulte “Startup 

Mode” (página II-50).

Importar e exportar 
arquivos Instantâneos

Você pode exportar os instantâneos armazenados na 
unidade para a drive flash USB e importar os instantâneos 
armazenados na drive flash USB para a unidade.

Instantâneos não podem ser importados ou exportados no 
modo 3D.

Exportar instantâneos

1 Insira a drive flash USB na porta USB da unidade.

2 Exiba o menu [File] e gire o botão V1 para selecionar 
[Export Snapshot], gire cada botão para especificar os 
arquivos a serem exportados e pressione o botão V4 
para iniciar a exportação.

Quando o botão V4 está pressionado, o número 
especificado de instantâneos é exportado.

A pasta para a qual os arquivos são exportados e os 
nomes de arquivo são como mostrados abaixo.
Nome da pasta: \Sony\MCS\SNAPSHOT
Nome do arquivo: YYMMDD-HHMMSS-##.SSS

(## é o número do instantâneo [01 a 20])

Ao exportar memórias de quadros, verifique se o 
número de arquivos na pasta não é maior do que 99.

Dica

Dica

Botão Parâmetro Significado Intervalo da 
configuração

V2 Source Número do primeiro 
instantâneo a ser 
exportado

SS1 a SS20

V3 Num Número de 
instantâneos a serem 
exportados

1 a 20

Dica

Nota
Importar e exportar arquivos Instantâneos
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portar e exportar arquivos
Importar instantâneos

1 Insira a drive flash USB que armazena os instantâneos 
que você deseja importar no conector USB da unidade.

2 Exiba o menu [File], gire o botão V1 para selecionar 
[Import Snapshot] e pressione o botão.

Os dados na drive flash USB são lidos e os 
instantâneos que podem ser importados são exibidos.

Arquivos de instantâneos são exibidos em ordem, 
iniciando com a mais antiga.

3 Gire o botão V1 para selecionar o instantâneo a ser 
importado, gire cada botão para especificar os 
instantâneos a serem registrados e pressione o botão 
V4 para iniciar a importação.

Quando o botão V4 está pressionado, o número 
especificado de instantâneos é importado.

Se um instantâneo já estiver armazenado com o 
número de instantâneo especificado, ele será 
sobrescrito pelo instantâneo importado.

Formatar a drive flash 
USB

1 Insira a drive flash USB na porta USB da unidade.

2 Exiba o menu [File], gire o botão V1 para selecionar 
[USB Memory Format] e pressione o botão V4 para 
iniciar a formatar.

As seguintes pastas são criadas quando a formatação é 
realizada.
Nome da pasta: \Sony\MCS\CONFIG

\Sony\MCS\FM
\Sony\MCS\SNAPSHOT

Dica

Botão Parâmetro Significado Intervalo da 
configuração

V2 Dest Número do 
primeiro 
instantâneo a 
serem exportado

SS1 a SS20

V3 Num Número de 
instantâneos a 
serem importados

1 a 20

Dica

Dica
II-41Formatar a drive flash USB
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Descrição

Com esta unidade você pode criar vídeo 3D importando 
um vídeo para o olho esquerdo (L) e um vídeo para o olho 
direito (R) como um par.
Este capítulo descreve as conexões e as configurações 
necessárias para o uso desta unidade como um sistema 3D. 

Fluxo de conexões e de configurações
Ao usar a unidade em um sistema 3D faça as seguintes 
configurações e conexões necessárias.

Os conectores para entrada e sada de sinais de vdeo 3D so fixos. Ao 

configurar um sistema 3D, consulte “Exemplo 2: Quando o Sistema 3D” 

(página II-6) em gExemplos de configurao do sistemah.

Notas e restrições
As seguintes restrições se aplicam durante a configuração 
de um sistema 3D incluindo a unidade MCS-8M.
• Configure o sistema 3D com apenas uma unidade. Duas 

unidades não podem ser vinculadas juntas.
• Quando a unidade é operada em um sistema 3D, apenas 

um formato de sinal HD (1080i/59.94, 1080i/50, 720p/
59.94 ou 720p/50) poderá ser usado. Se o formato de 
sinal for alterado de HD para SD, o 3D será cancelado.

• Áudio incorporado nas entradas HDMI não pode ser 
usado.

• Os conectores que podem ser usados para entrada de 
vídeo 3D e os botões de ponto cruzado aos quais os 
sinais de vídeo podem ser atribuídos são fixos, conforme 
mostrado abaixo.

• Os conectores aos quais os sinais de saída de vídeo 3D 
podem ser atribuídos são fixos conforme mostrados 
abaixo.

• Use um sinal de referência para sincronizar as imagens 
do dispositivo de entrada de vídeo 3D e esta unidade.

• O conector TALLY/GPI será dedicado ao TALLY. O 
TALLY ficará fixo em IN1 (SDI IN 1, IN 2) e IN2 (SDI 
IN 3, IN 4).

Conexão de cada um dos dispositivos (página II-6)

r

Configuração do formato de sinal e do tamanho do vídeo 
(página II-43)

r

Como ligar o modo 3D (página II-43)

r

Confirmação da saída de vídeo 3D (página II-44)

Conector de vídeo de 
entrada

Sinal de entrada Botão de ponto 
cruzado

SDI IN 1 SDI 1 (L) 1

SDI IN 2 SDI 1 (R)

SDI IN 3 SDI 2 (L) 2

SDI IN 4 SDI 2 (R)

Conector de saída de vídeo Sinal de saída Comentário

SDI OUT PGM PGM (L)

SDI OUT AUX 1 PGM (R)

SDI OUT AUX 2 PGM (L+R) Side by Side

SDI OUT MULTI VIEWER Multi Viewer

DVI-D OUT AUX PGM (L+R) Side by Side

DVI-D OUT MULTI VIEWER Multi Viewer
Descrição
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Realização das 
configurações 
necessárias

Faça as configurações de operação da unidade em um 
sistema 3D no meu [Setup].
Exiba o menu [Setup] pressionando o botão SETUP na 
seção de controle do menu.

Configuração do formato de sinal e 
do tamanho do vídeo

1 Exiba o menu [Setup], selecione o menu [System] > 
[System Format] e use os botões correspondentes para 
fazer cada uma das seguintes configurações.

A [Aspect] do vídeo é fixa em 16:9.

Para obter detalhes sobre a configuração, consulte “Configuração do 

formato do sinal e da relação de aspecto” (c Operações básicas).

2 Pressione o botão V3 ou V4.

Uma mensagem será exibida solicitando que você 
reinicie a unidade.

3 Pressione o botão V3 (OK).

Ativação do modo 3D

1 Exiba o menu [Setup], selecione o menu [System] > 
[3D Mode], gire o botão V4 para selecionar [On].

2 Pressione o botão V4.

Uma mensagem será exibida solicitando que você 
reinicie a unidade.

3 Pressione o botão V3 (OK) e desligue e ligue a 
unidade.

• No modo 3D, o botão de delegação de barramento 
BKGD acenderá e os botões KEY, AUX 1 e AUX 2 
serão desativados.

• A próxima transição está fixa no BKGD.
• Os tipos de transição ficarão fixos em MIX.
• Os botões FTB e KEY TRANS na seção do controle de 

transição serão desativados.
• A seção do teclado numérico será desativada.
• Na seção de controle de menu, apenas os botões MISC, 

FILE e SETUP serão ativados.
Além disso, os menus serão restritos conforme a seguir.

Menu [Misc]

Menu [Setup]

Botão Parâmetro Significado Valor da 
configuração

V3 Formato Formato do sinal 108059 (1080i/59.94), 
108050 (1080i/50), 
720p59 (720p/59.94), 
720p50 (720p/50)

V4 Aspecto Relação de 
aspecto do vídeo

16:9

Dica

Botão Parâmetro Significado Valor da 
configuração

V4 3D Desliga ou liga o modo 3D Off, On

Dicas

Item do menu Restrição

Transition 
Rate (1/2)

• Apenas a taxa de transição [Effect] está 
ativada.

Transition 
Rate (2/2)

• A configuração está desativada.

Color BKGD • A configuração está desativada.

Port Enable • [GPI] está fixo em [Disbl] (desativar).
• Apenas [RS232C] pode ser selecionado.

Item do menu Restrição

Video (XPT) • Movimento da configuração de sub-nível está 
desativado (atribuições de botões de ponto 
cruzado estão fixas).

Video (Output) • Movimento da configuração de sub-nível está 
desativado (atribuições de saída de vídeo 
estão fixas).

Multi Viewer • Apenas a configuração do número de subtelas 
está ativada.

• A atribuição de vídeo nas subtelas está fixa.

GPI/Tally • Movimento da configuração de sub-nível 
desativado.
II-43Realização das configurações necessárias
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Menu [File]

• Os seguintes dados não serão salvos pela operação 
[Startup Define] no menu [Setup]. Essas configurações 
retornarão para os valores padrão em cada inicialização.
– Botões de ponto cruzado PGM: 1
– Botões de ponto cruzado PST: 1
– Taxa de transição de efeito: 30

Confirmação da saída de vídeo 3D

A entrada de vídeo 3D é atribuída aos botões de ponto 
cruzado (botão PGM e botão PST/KEY) 1 e 2.
Pressione os botões de ponto cruzado 1 e 2 e confirme a 
saída do vídeo 3D.

Item do menu Restrição

Import 
Snapshot

• Movimento da configuração de sub-nível 
desativado.

Export 
Snapshot

• A exportação está desativada.
Realização das configurações necessárias



apítulo7
C
Controlar dispositivos 
externos
  C
apítulo 7  C

ontrolar dispositivos externos
Ativar/Desativar a 
operação por 
dispositivos externos

Ativar ou desativar a porta GPI que é usada para operação 
com dispositivos externos.

1 Exiba o menu [Misc], gire o botão V1 para selecionr 
[Port Enable] e use o botão V3 para fazer a 
configuração.

Conexão com 
dispositivos externos

Configure uma conexão com um dispositivo externo em 
[GPI/Tally] no menu [Setup].

No modo 3D, [GPI/Tally] não é exibido.

Para obter detalhes sobre os itens do menu [GPI/Tally], consulte “Lista de 

menu [GPI/Tally]” (página II-46).

Para obter detalhes sobre a atribuição de pinos do conector TALLY/GPI, 

consulte “Conector TALLY/GPI” (c Operações básicas).

Configuração de entradas de GPI

Configure a operação e acione o tipo de contatos de 
entrada GPI.

Menu Settings: Menu [Setup] > menu [GPI/Tally] > 
[GPI Input 1] a [GPI Input 4] (página II-46)

Você pode selecionar dentre as seguintes operações de 
contato.
NotUse: Sem operação
CT: Corte
AT: Transição automática
KeyCT: Corte de incorporação
KeyAT: Transição automática de incorporação
Aux1CT: Corte Aux1
Aux1AT: Transição automática Aux1
Aux2CT: Corte Aux2
Aux2AT: Transição automática Aux2
SS1 a SS20: Recuperação de instantâneo (1 a 20)

Você pode selecionar dentre os seguintes tipos de 
acionadores.
NotUse: O pulso de entrada é ignorado.
Rise: O acionador é aplicado na borda crescente do pulso 

de entrada.
Fall: O acionador é aplicado na borda decrescente do 

pulso de entrada.
Any: O acionador é aplicado quando o pulso de entrada é 

invertido.

Configuração GPI Outputs/Tallies

Definição das saídas GPI e tallies.

Menu Settings: Menu [Setup] > menu [GPI/Tally] > 
[GPI Output/Tally 1] a [GPI Output/Tally 8] 
(página II-47)

Botão Parâmetro Significado Intervalo da 
configuração

V3 GPI Ativa/desativa a porta 
GPI

Enbl (ativar), 
Disbl 
(desativar)

Dica
II-45Ativar/Desativar a operação por dispositivos externos / Conexão com dispositivos externos
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Você pode selecionar dentre os seguintes tipos de 
acionadores.
NotUse: A saída é fixa em um nível alto.
Rise: O acionador faz com que a saída seja reduzida a um 

nível baixo e esse status permanecerá por um 
determinado tempo (1 a 2 quadros).

Fall: O acionador faz com que a saída seja aumentada a 
um nível alto e esse status permanecerá por um 
determinado tempo (1 a 2 quadros).

Any: Toda vez que o acionador for ativado, os níveis alto 
e baixo da saída serão alternados.

Se as saídas GPI forem usadas como tallies, a relação entre 
o Tally 1 a 8 e os sinais de entrada é a seguinte.

Lista de menu [GPI/Tally]

Para exibir o menu [GPI/Tally], exiba o menu [Setup] e pressione o botão V1 enquanto [GPI/Tally] estiver selecionado.

Tally Sinal de entrada

1 SDI 1

2 SDI 2

3 SDI 3

4 SDI 4

5 DVI-1

6 HDMI-1/VIDEO 1

7 HDMI-2/VIDEO 2

8 HDMI-3/VIDEO 3

Item do 
menu

Descrição Botão Parâmetro Significado Intervalo da 
configuração

Página de 
referência

GPI Input 1 Configure a operação e acione o tipo de 
contatos de entrada 1 GPI.

V3 Action Operação de 
contato

NotUse, CT, AT, 
KeyCT, KeyAT, 
Aux1CT, Aux1AT, 
Aux2CT, Aux2AT, 
SS1 a SS20

II-45

V4 Edge Tipo de acionador NotUse, Rise, Fall, 
Any

GPI Input 2 Configure a operação e acione o tipo de 
contatos de entrada 2 GPI.

V3 Action Operação de 
contato

NotUse, CT, AT, 
KeyCT, KeyAT, 
Aux1CT, Aux1AT, 
Aux2CT, Aux2AT, 
SS1 a SS20

II-45

V4 Edge Tipo de acionador NotUse, Rise, Fall, 
Any

GPI Input 3 Configure a operação e acione o tipo de 
contatos de entrada 3 GPI.

V3 Action Operação de 
contato

NotUse, CT, AT, 
KeyCT, KeyAT, 
Aux1CT, Aux1AT, 
Aux2CT, Aux2AT, 
SS1 a SS20

II-45

V4 Edge Tipo de acionador NotUse, Rise, Fall, 
Any

GPI Input 4 Configure a operação e acione o tipo de 
contatos de entrada 4 GPI.

V3 Action Operação de 
contato

NotUse, CT, AT, 
KeyCT, KeyAT, 
Aux1CT, Aux1AT, 
Aux2CT, Aux2AT, 
SS1 a SS20

II-45

V4 Edge Tipo de acionador NotUse, Rise, Fall, 
Any
Lista de menu [GPI/Tally]
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GPI Output/
Tally 1

Defina a saída GPI 1 ou o Tally 1. V2 Use Seleciona se um 
tally ou uma saída 
GPI devem ser 
usados.

Tally, GPIOut (saída 
GPI)

II-45

V3 Action Operação quando 
usado como uma 
saída GPI

NotUse, CT, AT, 
KeyCT, KeyAT, 
Aux1CT, Aux1AT, 
Aux2CT, Aux2AT

V4 Edge Tipo de acionador 
quando usado 
como uma saída 
GPI

NotUse, Rise, Fall, 
Any

GPI Output/
Tally 2

Defina a saída GPI 2 ou o Tally 2. V2 Use Seleciona se um 
tally ou uma saída 
GPI devem ser 
usados.

Tally, GPIOut (saída 
GPI)

II-45

V3 Action Operação quando 
usado como uma 
saída GPI

NotUse, CT, AT, 
KeyCT, KeyAT, 
Aux1CT, Aux1AT, 
Aux2CT, Aux2AT

V4 Edge Tipo de acionador 
quando usado 
como uma saída 
GPI

NotUse, Rise, Fall, 
Any

GPI Output/
Tally 3

Defina a saída GPI 3 ou o Tally 3. V2 Use Seleciona se um 
tally ou uma saída 
GPI devem ser 
usados.

Tally, GPIOut (saída 
GPI)

II-45

V3 Action Operação quando 
usado como uma 
saída GPI

NotUse, CT, AT, 
KeyCT, KeyAT, 
Aux1CT, Aux1AT, 
Aux2CT, Aux2AT

V4 Edge Tipo de acionador 
quando usado 
como uma saída 
GPI

NotUse, Rise, Fall, 
Any

GPI Output/
Tally 4

Defina a saída GPI 4 ou o Tally 4. V2 Use Seleciona se um 
tally ou uma saída 
GPI devem ser 
usados.

Tally, GPIOut (saída 
GPI)

II-45

V3 Action Operação quando 
usado como uma 
saída GPI

NotUse, CT, AT, 
KeyCT, KeyAT, 
Aux1CT, Aux1AT, 
Aux2CT, Aux2AT

V4 Edge Tipo de acionador 
quando usado 
como uma saída 
GPI

NotUse, Rise, Fall, 
Any

GPI Output/
Tally 5

Defina a saída GPI 5 ou o Tally 5. V2 Uso Seleciona se um 
tally ou uma saída 
GPI devem ser 
usados.

Tally, GPIOut (saída 
GPI)

II-45

V3 Action Operação quando 
usado como uma 
saída GPI

NotUse, CT, AT, 
KeyCT, KeyAT, 
Aux1CT, Aux1AT, 
Aux2CT, Aux2AT

V4 Edge Tipo de acionador 
quando usado 
como uma saída 
GPI

NotUse, Rise, Fall, 
Any

Item do 
menu

Descrição Botão Parâmetro Significado Intervalo da 
configuração

Página de 
referência
II-47Lista de menu [GPI/Tally]
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GPI Output/
Tally 6

Defina a saída GPI 6 ou o Tally 6. V2 Use Seleciona se um 
tally ou uma saída 
GPI devem ser 
usados.

Tally, GPIOut (saída 
GPI)

II-45

V3 Action Operação quando 
usado como uma 
saída GPI

NotUse, CT, AT, 
KeyCT, KeyAT, 
Aux1CT, Aux1AT, 
Aux2CT, Aux2AT

V4 Edge Tipo de acionador 
quando usado 
como uma saída 
GPI

NotUse, Rise, Fall, 
Any

GPI Output/
Tally 7

Defina a saída GPI 7 ou o Tally 7. V2 Use Seleciona se um 
tally ou uma saída 
GPI devem ser 
usados.

Tally, GPIOut (saída 
GPI)

II-45

V3 Action Operação quando 
usado como uma 
saída GPI

NotUse, CT, AT, 
KeyCT, KeyAT, 
Aux1CT, Aux1AT, 
Aux2CT, Aux2AT

V4 Edge Tipo de acionador 
quando usado 
como uma saída 
GPI

NotUse, Rise, Fall, 
Any

GPI Output/
Tally 8

Defina a saída GPI 8 ou o Tally 8. V2 Use Seleciona se um 
tally ou uma saída 
GPI devem ser 
usados.

Tally, GPIOut (saída 
GPI)

II-45

V3 Action Operação quando 
usado como uma 
saída GPI

NotUse, CT, AT, 
KeyCT, KeyAT, 
Aux1CT, Aux1AT, 
Aux2CT, Aux2AT

V4 Edge Tipo de acionador 
quando usado 
como uma saída 
GPI

NotUse, Rise, Fall, 
Any

On Air 
Source

Defina o sinal de referência para o tally no ar.

Notas sobre valores de configuração
PGM: Saída de tally para sinais de entrada 

emitidos pelo PGM.
Aux1: Saída de tally para sinais de entrada 

emitidos pelo AUX 1.
Aux2: Saída de tally para sinais de entrada 

emitidos pelo AUX 2.

V4 Source Sinal de referência 
para tally no ar

PGM, Aux1, Aux2 –

Item do 
menu

Descrição Botão Parâmetro Significado Intervalo da 
configuração

Página de 
referência
Lista de menu [GPI/Tally]
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Descrição

Configure o sistema como um todo no menu [Setup].

O menu [Setup] contém os seguintes itens.

Para exibir o menu [Setup]
Pressione o botão SETUP na seção de controle do menu.

Para selecionar um item de menu
Exiba o menu [Setup] e gire o botão V1 para selecionarum 
item de menu.

Configuração do sistema 
(System)

Faça configurações relacionadas ao sistema nos itens do 
menu [Setup] > menu [System].

Sinais de referência de entrada 
suportados
Você pode usar qualquer um dos seguintes sinais como o 
sinal de referência de entrada da unidade.

Item do menu Descrição Página de 
referência

Startup Define Salva os dados de configuração 
atuais.

Operações 
básicas

System Faz configurações relacionadas 
ao sistema.

II-49

Audio Faz configurações relacionadas 
ao áudio.

II-51

Video (Input) Faz configurações relacionadas à 
entrada de vídeo.

II-53

Video (XPT) Atribui sinais de entrada de vídeo 
aos botões de ponto cruzado.

II-54

Video (Output) Faz configurações relacionadas à 
saída de vídeo.

II-55

Video (Misc) Faz outras configurações 
relacionadas ao vídeo.

II-56

Multi Viewer Configura o Multi Viewer. Operações 
básicas

GPI/Tally Faz outras configurações 
relacionadas a controle de GPI e 
tally.

II-45

Information Exibe várias informações sobre a 
unidade.

II-56

Install Instalar software e firmware do 
aplicativo.

II-56

Formato do 
sinal

Sinal de referência de entrada

HD Tri Sync SD Black Burst

HD system 1080i/59.94 59.94 59.94

1080i/50 50 50

720p/59.94 59.94 59.94

720p/50 50 50

SD system 480i/59.94 – 59.94

576i/50 – 50
II-49Descrição / Configuração do sistema (System)
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Detalhes do menu [System]

Item do 
menu

Descrição Botão Parâmetro Significado Intervalo da 
configuração

Confirmação 
(pressione o 
botão)

System 
Format

Defina o formato e a relação de aspecto a ser 
usada pela unidade.
(c Operações básicas: “Configuração do 
formato do sinal e da relação de aspecto”)

 Dica
Se você pressionar o botão V3 ou V4, será 
exibida uma mensagem solicitando que você 
reinicie a unidade. Pressione o botão V3 (OK) 
e desligue e ligue a unidade.

V3 Format Formato do sinal 108059, 108050, 
720p59, 720p50, 
480i59, 576i50, 
Test1, Test2, 
Test3

Necessário

V4 Aspect Taxa de aspecto 16:9, 4:3 Necessário

3D Mode Quando estiver usando um sistema 3D, ligue o 
modo 3D.
(Consulte “Ativação do modo 3D” (página 
II-43))

V4 3D Desliga ou liga o 
modo 3D

Off, On Necessário

System 
Reference

Seleciona o sinal de referência de entrada.
BB (Black Burst): Sinal Black burst
Tri (Tri Sync): Sincronia de três níveis para 

sistema HD
INT (Internal): Sinal de referência interna da 

unidade (consulte “Sinais de referência de 
entrada suportados” (página II-49))

 Dica
Se você pressionar o botão V4, será exibida 
uma mensagem solicitando que você reinicie a 
unidade. Pressione o botão V3 (OK) e desligue 
e ligue a unidade.

V4 Ref Sinal de referência 
de entrada

BB, Tri, INT Necessário

REF OUT 
Phase

Selecione a fase do sinal de referência de 
saída usando o vídeo de saída como base.

Notas sobre valores de configuração
-1: Uma linha antes do vídeo de saída.
0: Fase igual como vídeo de saída.

 Dica
Se você pressionar o botão V4, será exibida 
uma mensagem solicitando que você reinicie a 
unidade. Pressione o botão V3 (OK) e desligue 
e ligue a unidade.

V4 Phase Fase do sinal de 
referência de saída

–1, 0 Necessário

Startup 
Mode

Seleciona o modo de configuração (modo de 
inicialização) usado pela unidade na 
inicialização.
Fact (Factory): Inicia com as configurações 

padrão de fábrica.
User: Inicia usando os dados de configuração 

salvos no menu [Setup] > [Startup 
Define].

(c Operações básicas: “Como salvar e 
selecionar configurações”)

V4 Def Modo de 
inicialização

Fact, User Necessário

Date Define a data do relógio interno da unidade.
(c Operações básicas: “Configuração de data 
e hora”)

V2 Year Ano 2000 a 2099 Necessário

V3 Month Mês 1 a 12 Necessário

V4 Day Dia 1 a 31 Necessário

Time Define o horário do relógio interno da unidade.
(c Operações básicas: “Configuração de data 
e hora”)

V3 Hour Hora 0 a 23 Necessário

V4 Min Minuto 0 a 59 Necessário

LCD 
Backlight

Ajusta o brilho da luz de fundo do visor do 
menu.

V4 Bright Brilho da 
iluminação traseira 
do LCD

Min (mínimo), 1, 
2, 3, 4, 5, 6, Max 
(máximo) 

Não necessário
Configuração do sistema (System)
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Configuração de áudio (Audio)

Atribui entradas de sinal de áudio para faders de canal e faz configurações relacionadas ao áudio nos itens do menu [Setup] 
> menu [Audio].

Combinações de sinal de áudio e áudio incorporado na saída SDI
A tabela a seguir mostra as possíveis combinações de saída.

PGM e MIX são tratados como um par.
• Quando PGM/MIX está atribuído para L ou R, a mesma atribuição é feita ao outro automaticamente. Por exemplo, se L 

for atribudo a “PGM-L,” R ser atribudo a “PGM-R.”
• Se L ou R forem ento atribudos a um item diferente de PGM/MIX, o outro ser definido automaticamente como “None.”

Detalhes do menu [Audio]

Áudio incorporado Possíveis combinações de saída

SDI 1 a 4 (E) PGM-L MIX-L AUX 1 AUX 2 AUX 1 AUX 2 AUX 1 AUX 2 Nenhuma Nenhuma

SDI 1 a 4 (D) PGM-R MIX-R AUX 1 AUX 2 AUX 2 AUX 1 Nenhuma Nenhuma AUX 1 AUX 2

Dica

Item do 
menu

Descrição Botão Parâmetro Significado Intervalo da 
configuração

Audio Input 
Assign 1

a
Audio Input 
Assign 6

Atribua os sinais de entrada de áudio dos conectores de 
entrada de áudio aos faders de canal de 1 a 6.
(c Operações básicas: “Atribuir sinais de entrada de áudio 
a faders de canal”)

 Dica
No modo HD, SDI 1 a 4 e HDMI 1 a 3 são tratados como 
pares.
• Quando o áudio incorporado está atribuído para L ou R, a 

mesma atribuição é feita ao outro automaticamente. Por 
exemplo, se L for atribudo a “SDI1L” R ser atribudo a 
“SDI1R.”

• Se L ou R forem ento atribudos a um item diferente de 
udio incorporado, por exemplo, L8, o outro ser definido 
automaticamente como “NotUse.”

V3 Left Sinal de áudio L NotUse, M/L1, M/L2, 
M/L3, M/L4, M/L5, 
M/L6, L7, L8, SDI1L, 
SDI2L, SDI3L, SDI4L, 
HDMI1L, HDMI2L, 
HDMI3L

V4 Right Sinal de áudio R NotUse, M/L1, M/L2, 
M/L3, M/L4, M/L5, 
M/L6, L7, L8, SDI1R, 
SDI2R, SDI3R, 
SDI4R, HDMI1R, 
HDMI2R, HDMI3R

MIC/LINE 1 
Level

a
MIC/LINE 6 
Level

Ajuste o nível do microfone/linha para cada fader de canal. 
Ajuste um nível quando, por exemplo, as luzes de indicação 
de valor máximo acendam em vermelho ou quando a 
indicação do sinal de entrada não acende mesmo que haja 
entrada de um sinal de áudio.
(c Operações básicas: “Atribuir sinais de entrada de áudio 
a faders de canal”)

V4 Level Nível de entrada –44 dB, –20 dB, +4 dB

SDI OUT 
PGM Assign

Atribua a saída dos sinais de áudio dos conectores PGM 
OUT/MIX OUT/AUX OUT 1/AUX OUT 2 à saída de áudio 
incorporado do conector PGM de SDI OUT.

Para obter detalhes sobre as possíveis combinações de saída, consulte 
página II-51.

V3 Left Sinal de áudio a 
atribuir

None, PGM-L, MIX-L, 
AUX1, AUX2

V4 Right Sinal de áudio a 
atribuir

None, PGM-R, MIX-R, 
AUX1, AUX2

SDI OUT 
AUX1 Assign

Atribua a saída dos sinais de áudio dos conectores PGM 
OUT/MIX OUT/AUX OUT 1/AUX OUT 2 à saída de áudio 
incorporado do conector AUX 1 de SDI OUT.

Para obter detalhes sobre as possíveis combinações de saída, consulte 
página II-51.

V3 Left Sinal de áudio a 
atribuir

None, AUX1, AUX2, 
PGM-L, MIX-L

V4 Right Sinal de áudio a 
atribuir

None, AUX1, AUX2, 
PGM-R, MIX-R
II-51Configuração de áudio (Audio)
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SDI OUT 
AUX2 Assign

Atribua a saída dos sinais de áudio dos conectores PGM 
OUT/MIX OUT/AUX OUT 1/AUX OUT 2 à saída de áudio 
incorporado do conector AUX 2 de SDI OUT.

Para obter detalhes sobre as possíveis combinações de saída, consulte 
página II-51.

V3 Left Sinal de áudio a 
atribuir

None, AUX1, AUX2, 
PGM-L, MIX-L

V4 Right Sinal de áudio a 
atribuir

None, AUX1, AUX2, 
PGM-R, MIX-R

SDI OUT 
MULTI 
VIEWER 
Assign

Atribua a saída dos sinais de áudio dos conectores PGM 
OUT/MIX OUT/AUX OUT 1/AUX OUT 2 à saída de áudio 
incorporado do conector MULTI VIEWER de SDI OUT.

Para obter detalhes sobre as possíveis combinações de saída, consulte 
página II-51.

V3 Left Sinal de áudio a 
atribuir

None, AUX1, AUX2, 
PGM-L, MIX-L

V4 Right Sinal de áudio a 
atribuir

None, AUX1, AUX2, 
PGM-R, MIX-R

Audio Output 
Delay 1

Permite atrasar a saída de áudio dos conectores PGM OUT 
e MIX OUT em uma base de quadros. Se o vídeo estiver 
atrasado no áudio, você pode ajustar o áudio para 
sincronizá-lo com o vídeo.

Nota
Ajustar o tempo de atraso pode provocar geração de ruídos.

V3 PGM Tempo de atraso 
para saída de 
áudio do conector 
PGM OUT

0.00 a 7.50 frames 
(1.00)

V4 MIX Tempo de atraso 
para saída de 
áudio do conector 
MIX OUT

0.00 a 7.50 frames 
(1.00)

Atraso na 
saída de 
áudio 2

Permite atrasar a saída de áudio dos conectores AUX OUT 
1 e 2 em uma base de quadros. Se o vídeo estiver atrasado 
no áudio, você pode ajustar o áudio para sincronizá-lo com 
o vídeo.

Nota
Ajustar o tempo de atraso pode provocar geração de ruídos.

V3 AUX1 Tempo de atraso 
para saída de 
áudio do conector 
AUX OUT 1

0.00 a 7.50 frames 
(1.00)

V4 AUX2 Tempo de atraso 
para saída de 
áudio do conector 
AUX OUT 2

0.00 a 7.50 frames 
(1.00)

Output Level Ajuste o nível de saída de áudio para cada destino de 
saída.

 Dica
O nível de saída da saída de áudio do conector SDI OUT 
PGM pode ser ajustado com o fader de programa na seção 
de controle de áudio.

V2 MIX Nível de saída do 
conector MIX OUT

–∞ a +10 dB (0 dB)

V3 AUX1 Nível de saída do 
conector AUX OUT 
1

–∞ a +10 dB (0 dB)

V4 AUX2 Nível de saída do 
conector AUX OUT 
2

–∞ a +10 dB (0 dB)

Oscillator Serve para realizar as configuraçõs do sinal de saída do 
oscilador usado para ajuste.

 Dica
Se algo diferente de gOffh for selecionado em [Freq] 
quando o destino de sada do sinal do oscilador estiver 
definido como [Term], o boto DIM acende e o nvel de sada 
dos fones de ouvido ou do monitor reduzido 
automaticamente.

V2 Freq Frequência do sinal 
do oscilador

Off, 100 Hz, 440 Hz, 
1 kHz, 10 kHz

V3 Level Output level of 
oscillator signal

–∞ to 0 dB (–20 dB)

V4 Term Terminação do 
sinal do oscilador

None, PGM, MIX, 
AUX1, AUX2, All 
(todos os destinos de 
saída)

Item do 
menu

Descrição Botão Parâmetro Significado Intervalo da 
configuração
Configuração de áudio (Audio)
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Configuração de entrada de vídeo (Video (Input))

Faça configurações relacionadas à entrada de vídeo nos itens do menu [Setup] > menu [Video (Input)].

Sobre sinais de entrada DVI
• Defina a resolução do sinal DVI de entrada em um dos seguintes de acordo com a configuração do formato de sinal da 

unidade (página II-50). As imagens normais podem não poder ser obtidas em outras resoluções.

Ainda que os sinais com resoluções diferentes de 1920 × 1080 possam ser aceitos quando os sinais de entrada DVI estão 
definidos como digital, a operação não é garantida.

• O tamanho da imagem dos sinais de entrada DVI serão ajustados para caber na tela do formato de sinal da unidade 
enquanto mantém a relação de aspecto.

Detalhes do menu [Video (Input)]

Sinal Resolução 1080i/59.94, 
1080i/50

720p/59.94, 720p/50, 
480i/59.94, 576i/50

Analógico XGA (60 Hz) 1024 × 768 Sim Sim

WXGA (60 Hz) 1280 × 768 Sim Sim

SXGA (60 Hz) 1280 × 1024 Sim Sim

Digital HDTV (50 Hz) 1920 × 1080 Sim –

HDTV (60 Hz) 1920 × 1080 Sim –

Dica

Item do 
menu

Descrição Botão Parâmetro Significado Intervalo da 
configuração

SDI1
a

SDI4

Define os sinais SDI para entrada pelos conectores SDI IN 
1 a 4.

V3 FS Sincronizador de 
quadros

Off, On

V4 Name Nome da origem de 
entrada

IN1 a IN8, CAM1 a 8, 
VTR1 a 8, PC1 a 8, 
SDI1 a 4, DVI, HDMI1 
a 3, VIDEO1 a 3

DVI Define o formato e o nome da origem de entrada do sinal a 
ser inserido pelo conector DVI-I IN. Quando você alterar o 
formato do sinal, pressione o botão V3 para confirmar a 
alteração. 
• Para obter detalhes sobre o sinal DVI a ser inserido, 

consulte “Sobre sinais de entrada DVI” (página II-53).
• Para obter detalhes relativos aos formatos dos sinais de 

entrada de vídeo DVI-I, consulte também “Configuração 
do formato de entrada do sinal no conector DVI-I” 
(c Operações básicas).

V3 Format Formato do sinal 
de vídeo de 
entrada DVI-I

XGA, SXGA, WXGA, 
HDTV50, HDTV60

V4 Name Nome da origem de 
entrada

IN1 a IN8, CAM1 a 8, 
VTR1 a 8, PC1 a 8, 
SDI1 a 4, DVI, HDMI1 
a 3, VIDEO1 a 3

HDMI1
a

HDMI3

Defina os nomes de origem de entrada dos sinais de 
entrada HDMI a serem inseridos pelos conectores HDMI IN 
1 a 3.

V4 Name Nome da origem de 
entrada

IN1 a IN8, CAM1 a 8, 
VTR1 a 8, PC1 a 8, 
SDI1 a 4, DVI, HDMI1 
a 3, VIDEO1 a 3

VIDEO1
a

VIDEO3

Defina os níveis do pedestal e os nomes de origem de 
entrada dos sinais de entrada de vídeo HDMI a serem 
inseridos pelos conectores VIDEO IN 1 a 3.
Quando você alterar um nível de pedestal, confirme a 
modificação pressionando o botão V3.

V3 Setup Nível do pedestal 0IRE, 7.5IRE

V4 Name Nome da origem de 
entrada

IN1 a IN8, CAM1 a 8, 
VTR1 a 8, PC1 a 8, 
SDI1 a 4, DVI, HDMI1 
a 3, VIDEO1 a 3
II-53Configuração de entrada de vídeo (Video (Input))
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Atribuir sinais de entrada 
de vídeo aos botões de 
ponto cruzado (Video 
(XPT))

Atribui sinais de vídeo aos botões de ponto cruzado 
(botões PGM e PST/KEY) nos itens do menu [Setup] > 
menu [Video (XPT)].

Para obter detalhes sobre o procedimento de configuração, consulte 

“Atribuir sinais de vídeo aos botões de ponto cruzado” (c Operações 

básicas).

No modo 3D, o menu não é exibido.

Uso da função botão shift

Ao usar o botão de ponto cruzado 8/SHIFT como o botão 
Shift, você pode atribuir um total de 14 materiais (sete aos 
botões de ponto cruzado de 1 a 7 e sete aos botões cruzados 
1 a 7 + botão Shift (botão de ponto cruzado 8/SHIFT)).

Menu Settings: [XPT Shift Mode] (página II-54)

Os números são atribuídos aos botões cruzados como 
mostrado abaixo, dependendo se a função botão Shift está 
ligada ou desligada.

Função botão shift: Off (modo não shift)

Função botão shift: On (modo shift)

A tabela a seguir mostra as configurações padrão de 
fábrica para as atribuições.

Detalhes do menu [Video (XPT)]

Dica

Botão de ponto 
cruzado PGM/PST

Valor inicial

1 a 4 SDI IN 1 a 4 (SDI1 a SDI4)

5 DVI-I (DVI)

6 a 8 HDMI IN 1 a 3 (H/V1 a H/V3) no modo HD
VIDEO IN 1 a 3 (H/V1 a H/V3) no modo SD

9 Fundo colorido (ColBg)

10 Memória de quadro (FM)

11 Saída do programa (PGM)

12 a 14 Sinal preto (Black)

1 2 3 4 5 6 7 8

1 2 3 4 5 6 7
8 9 10 11 12 13 14 Shift

Item do 
menu

Descrição Botão Parâmetro Significado Intervalo da 
configuração

XPT Assign 
1

a
XPT Assign 
14

Atribua a entrada de sinais de vídeo dos conectores de 
entrada de vídeo e os sinais gerados internamente aos 
botões de ponto cruzado 1 a 14 (botões PGM/KEY).

V4 Source Sinais de vídeo Black, SDI1 a 4, DVI, 
H/V1 a 3, ColBg, FM, 
PGM

XPT Shift 
Mode

Selecione se o botão de ponto cruzado 8 deverá ser usado 
como botão Shift.
Hold: O botão opera como um botão shift e os botões de 

ponto cruzado na parte do Shift são ativados enquanto 
o botão está pressionado.

Lock: O botão opera como um botão shift e cada pressão 
alterna entre as atribuições na parte do shift e na parte 
não shift.

Off: O botão opera como um botão de ponto cruzado 8.

V4 Mode Alterna entre shift e 
não shift

Off, Hold, Lock
Atribuir sinais de entrada de vídeo aos botões de ponto cruzado (Video (XPT))
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Configuração de saída de vídeo (Video (Output))

Defina o sinal de saída de vídeo para ser atribuído a cada conector de saída de vídeo nos itens do menu [Setup] > menu 
[Video (Output)].

No modo 3D, o menu não é exibido.

Detalhes do menu [Video (Output)]

Dica

Item do 
menu

Descrição Botão Parâmetro Significado Intervalo da 
configuração

SDI OUT 
PGM Assign

Selecione o sinal para atribuir ao conector SDI OUT PGM.

Notas sobre valores de configuração
PGM: Programa
PVW: Pré-visualização
Aux1PG: Programa Aux1
Aux1PV: Pré-visualização Aux1
Aux2PG: Programa Aux2
Aux2PV: Pré-visualização Aux2
MV: Multi Viewer

V4 Output Sinal de saída de 
vídeo

PGM, PVW, Aux1PG, 
Aux1PV, Aux2PG, 
Aux2PV, MV

SDI OUT 
AUX1 Assign

Selecione o sinal para atribuir ao conector SDI OUT AUX 1. V4 Output Sinal de saída de 
vídeo

PGM, PVW, Aux1PG, 
Aux1PV, Aux2PG, 
Aux2PV, MV

SDI OUT 
AUX2 Assign

Selecione o sinal para atribuir ao conector SDI OUT AUX 2. V4 Output Sinal de saída de 
vídeo

PGM, PVW, Aux1PG, 
Aux1PV, Aux2PG, 
Aux2PV, MV

SDI OUT 
MULTI 
VIEWER 
Assign

Selecione o sinal para atribuir ao conector SDI OUT MULTI 
VIEWER.

V4 Output Sinal de saída de 
vídeo

PGM, PVW, Aux1PG, 
Aux1PV, Aux2PG, 
Aux2PV, MV

DVI OUT 
AUX Assign

Selecione o sinal a ser atribuído ao conector DVI-D OUT no 
modo HD e ao conector VIDEO OUT AUX no modo SD.

V4 Output Sinal de saída de 
vídeo

PGM, PVW, Aux1PG, 
Aux1PV, Aux2PG, 
Aux2PV, MV

DVI OUT 
MULTI 
VIEWER 
Assign

Selecione o sinal para atribuir ao conector DVI-D OUT 
MULTI VIEWER.

V4 Output Sinal de saída de 
vídeo

PGM, PVW, Aux1PG, 
Aux1PV, Aux2PG, 
Aux2PV, MV

VIDEO Defina o nível do pedestal do sinal de saída de vídeo que 
sairá pelo conector VIDEO OUT AUX.
Quando você alterar um nível de pedestal, confirme a 
modificação pressionando o botão V4.

V4 Setup Define o nível do 
pedestal do 
conector VIDEO 
OUT AUX

0IRE, 7.5IRE
II-55Configuração de saída de vídeo (Video (Output))
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Configuração de outros itens relacionados ao vídeo 
(Video (Misc))

Faça outras configurações relacionadas a vídeos nos itens do menu [Setup] > menu [Video (Misc)].

Detalhes do menu [Video (Misc)]

Exibição de várias 
informações 
(Information)

Você pode confirmar várias informações no software do 
aplicativo e no firmware nos itens do menu [Setup] > 
[Information].

Instalar software e 
firmware do aplicativo 
(Install)

Instale o software e o firmware do aplicativo na unidade 
pelo menu [Setup] > [Install].

Não é possível selecionar individualmente qual software a 
ser instalado. Todos os softwares e firmwares de 
aplicativos são instalados juntos de uma vez.

1 Copie o software a ser instalado na drive flash USB e 
insira a drive flash USB na porta USB da unidade.

Copie o software a ser instalado na seguinte pasta.
Nome da pasta: \Sony\MCS\INSTALL

2 Exiba o menu [Setup] > [Install] e pressione o botão 
V4 para iniciar a instalação.

Quando a instalação estiver concluída, uma mensagem 
será exibida solicitando que você reinicie a unidade. 
Confirme que não há erros (ou seja, que “E” não está 
sendo exibido).

Para obter detalhes sobre a mensagem que aparece na 
conclusão da instalação, consulte “Lista de 
mensagens” (página II-57).

3 Pressione o botão V3 (OK) e desligue e ligue a 
unidade.

4 Verifique as informações da versão do software e do 
firmware do aplicativo em [Information] mo menu 
[Setup] e desligue e ligue a unidade.

Item do 
menu

Descrição Botão Parâmetro Significado Intervalo da 
configuração

Switch 
Timing

Define o tempo para alternar os vídeos.

 Dica
Se o formato do sinal estiver definido como 720p, esta 
seleção será desativada.

V4 Timing Tempo de 
alternância

Any (campo mais 
rápido que pode ser 
processado), Field1 
(primeiro campo), 
Field2 (segundo 
campo)

Fade To 
Black

Ativa ou desativa o botão FTB da seção de controle de 
transição.

V4 Button Ativa/desativa o 
botão FTB

Enbl (ativar), Disbl 
(desativar)

Dica

Dica

Dica
Configuração de outros itens relacionados ao vídeo (Video (Misc)) / Exibição de várias informações (Information) / Instalar software e firmware do aplicativo (Install)
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Lista de mensagens

Quando acontecer um problema na unidade durante a 
operação, os seguintes tipos de mensagens aparecem. 
Antes de entrar em contato com seu representante Sony 
local, consulte as listas a seguir e verifique as soluções 
possíveis. Se o problema persistir, escreva o número da 
mensagem que aparece e entre em contato com seu 
representante Sony local.

Exemplo de mensagem:

Existem os seguintes tipos de mensagens.
 (Erro) : Indica uma incapacidade de continuar a 
operação, um problema no funcionamento ou outro 
erro grave.

 (Aviso) : Indica que poderá haver problemas se você 
continuar com a operação.

 (Informações) : Indica uma notificação.

Erros

0001

Rate

30
SS Mon

PGM

File 4203

Selec t

USB memory is not recognized.
Confirm the USB memory.

Enter

Tipo de mensagem

ID da 
mensagem

Mensagem

ID Mensagem (Inglês) Tradução Solução

4001 An internal fan is stopped. 
Please turn off the system immediately.

Um ventilador interno está parado. 
Desligue o sistema imediatamente.

O ventilador parou. Desligue a unidade 
imediatamente e entre em contato com seu 
representante Sony local.

4002 The temperature in the system is rising. 
Please turn off the system immediately.

A temperatura do sistema está subindo. 
Desligue o sistema imediatamente.

A temperatura interna do sistema está alta. 
Desligue a unidade imediatamente e entre 
em contato com seu representante Sony 
local.

4003 Unable to start.
Please restart.

Impossível iniciar.
Reinicialize.

Tente reinicializar a unidade. Se a unida não 
reinicializar entre em contato com seu 
representante Sony local.

4004 Unable to start.
Please restart.

Impossível iniciar.
Reinicialize.

Tente reinicializar a unidade. Se a unida não 
reinicializar entre em contato com seu 
representante Sony local.

4005 Unable to start.
Please restart.

Impossível iniciar.
Reinicialize.

Tente reinicializar a unidade. Se a unida não 
reinicializar entre em contato com seu 
representante Sony local.

4201 Loading configuration file error. Erro de carregamento de arquivo de 
configuração.

O arquivo de configuração selecionado 
pode não ser um arquivo suportado pelo 
MCS-8M ou pode estar danificado.
II-57Lista de mensagens



II-58

  A
nexo
Avisos

4202 Saving configuration file error.
Please retry.

Erro de salvamento de arquivo de 
configuração.
Tente novamente.

O arquivo de configuração não pôde ser 
salvo. A drive flash USB pode estar com um 
problema de funcionamento ou pode não 
ser suportada.

4203 USB memory is not recognized.
Confirm the USB memory.

A memória USB não foi reconhecida.
Confirme a memória USB.

Consulte se a opção foi verificada com o 
respectivo modelo de drive flash USB.
Se a operação tiver sido verificada, a drive 
flash USB poderá estar danificada.

4204 Formatting USB memory error.
Please retry.

Erro de formatação da memória USB.
Tente novamente.

4205 Reading folder/file error.
Confirm the folder/file.

Erro de leitura de pasta/arquivo.
Confirme a pasta / o arquivo.

4206 Making folder/file error.
Please retry.

Erro de criação de pasta/arquivo.
Tente novamente.

4207 Importing error.
Please retry.

Erro de importação.
Tente novamente.

4208 Exporting error.
Please retry.

Erro de exportação.T
ente novamente.

4209 More than 99 files exist in the folder. Há mais de 99 arquivos na pasta. Use um computador ou outro dispositivo 
para excluir arquivos desnecessários da 
pasta para que o número de arquivos não 
ultrapasse 99.

4210 No file in the folder.
Confirm the folder.

Não há arquivos na pasta.
Confirme a pasta.

Os arquivos não existem na pasta na drive 
flash USB usada como a origem de 
importação. Verifique a pasta na drive flash 
USB. 

Para obter detalhes sobre a configuração de 
pastas, consulte a “Formatar a drive flash USB” 
(página II-41).

4211 No data to export.
Confirm the source.

Não há dados para exportar.
Confirme a origem.

Os dados especificados para exportação 
não existem na unidade. Verifique se a 
memória de quadros, o instantâneo ou 
outros dados especificados para 
exportação foram criados.

4212 Importing error.
Unsupported format.

Erro de importação.
Formato não suportado.

Verifique os requisitos de arquivos TGA, 
TIFF e BMP que podem ser importados.
(Consulte a página II-37)

ID Mensagem (Inglês) Tradução Solução
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3001 No reference signal input state detected. 
Please confirm that the reference cable is 
properly configured.

Não foi detectado um estado de entrada de 
sinal de referência. 
Confirme que o cabo de referência está 
configurado de forma apropriada.

A entrada do sinal de referência não existe, 
ainda que o sinal de referência esteja 
configurado como [BB] ou [Tri].
Configure [System Reference] como [INT] 
ou conecte o sinal de referência apropriado.
(Consulte a página II-50)

3002 Reference signal unlock state detected. 
Please confirm that the reference cable is 
properly configured.

Estado de desbloqueio de sinal de 
referência detectado. 
Confirme que o cabo de referência está 
configurado de forma apropriada.

A frequência da entrada do sinal de 
referência não corresponde à do formato do 
sistema ou não está bloqueada. Verifique a 
entrada do sinal de referência.
(“Detalhes do menu [System]” (página II-
50))

3003 Signal Format of HDMI IN 1 is different from 
the setting. 
Please match the signal format to the 
system format.

O formato do sinal de HDMI IN 1 é diferente 
da configuração. 
Corresponda o formato do sinal ao formato 
do sistema.

O formato do sinal de entrada do conector 
HDMI IN 1 não corresponde ao formato do 
sistema. Corresponda o sinal ao formato do 
sistema.
Lista de mensagens
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3004 Signal Format of HDMI IN 2 is different from 
the setting. 
Please match the signal format to the 
system format.

O formato do sinal de HDMI IN 2 é diferente 
da configuração. 
Corresponda o formato do sinal ao formato 
do sistema.

O formato do sinal de entrada do conector 
HDMI IN 2 não corresponde ao formato do 
sistema. Corresponda o sinal ao formato do 
sistema.

3005 Signal Format of HDMI IN 3 is different from 
the setting. 
Please match the signal format to the 
system format.

O formato do sinal de HDMI IN 3 é diferente 
da configuração. 
Corresponda o formato do sinal ao formato 
do sistema.

O formato do sinal de entrada do conector 
HDMI IN 3 não corresponde ao formato do 
sistema. Corresponda o sinal ao formato do 
sistema.

ID Mensagem (Inglês) Tradução Solução
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1101 The setting is changed. 
Perform "Startup Define", and then restart.

A configuração é alterada. 
Execute “Startup Define” e reinicialize.

Isso aparece quando você altera o formato 
do sistema ou o modo 3D ou quando o 
sistema precisa ser reinicializado de outra 
maneira.
Execute [Startup Define] e reinicialize a 
unidade.

1102 Finished. Please restart.
M: xx/B: xx/F: xx/R: xx/Font: xx
FPGA1: xx/2: xx/3: xx/4: xx

M: Main 
B: Boot 
F: Firmware 
R: Register 
Font: Font 

xx:
• "O": OK
• "E": Error
• "–": Not installed

Concluído. Reinicialize.
M: xx/B: xx/F: xx/R: xx/Font: xx
FPGA1: xx/2: xx/3: xx/4: xx

M: Indica principal
B: Indica inicialização
F: Indica firmware
R: Indica registro
Font: Indica fonte

xx:
• “O”: OK
• “E”: Erro
• “–”: Não instalado

Isso aparece para exibir os resultados após 
a conclusão da instalação do software e do 
firmware do aplicativo.
Se “E” (erro) aparecer, tente instalar 
novamente. Se o problema persistir, entre 
em contato com seu representante Sony 
local.

1103 Import Finished. 
Please restart.

Importação concluída. 
Reinicialize.

Isso aparece quando a importação de uma 
configuração é concluída. Reinicialize a 
unidade.
II-59Lista de mensagens
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